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SOFTWARE LICENSE AGREEMENT

ACI grants you a non-transferable, non-exclusive license to use this
copy of the program and accompanying materials according to the
following terms:

LICENSE:

You may:

a) use the program on only one computer at a time;

b) make one (1) copy of the program in machine readable form solely
for backup purposes, provided that you reproduce all proprietary
notices on the copy;

c) physically transfer the program from one computer to another,
provided that the program is used on only one computer at a time; and
d) transfer the program onto a hard disk only for use as described
above provided that you can immediately prove ownership of the
original diskettes.

You may not:

a) use the program in a network unless you pay for a separate license
for each terminal or workstation from which the program will be
accessed;

b) modify, translate, reverse engineer, decompile, disassemble, cre-
ate derivative works based on, or copy (except for the backup copy) the
program or accompanying materials;

c) rent, transfer or grant any rights in the program in any form or
accompanying materials to any person without the prior written consent
of ACI which, if given, is subject to the conferee’s consent to the terms
and conditions of this license; or

d) remove any proprietary notices, labels or marks on the program and
accompanying materials.

This license is not a sale. Title and copyrights to the program, accom-
panying materials and any copy made by you remain with ACI.
TERMINATION

Unauthorized copying of the program (alone or merged with other
software) or the accompanying materials, or failure to comply with the
above restrictions will result in automatic termination of this license and
will make available to ACI other legal remedies. Upon termination you
will destroy or return to ACI the program, accompanying materials and
any copies.

LIMITED WARRANTY AND DISCLAIMER

THE PROGRAM AND ACCOMPANYING MATERIALS ARE PRO-
VIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.

k
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ACI does not warrant that the functions contained in the program will
meet your requirements or that the operation will be uninterrupted or
error free. The entire risk as to the use, quality, and performance of the
program is with you. Should the program prove defective, you, and not
ACI, assume the entire cost of any necessary repair.

However, ACl warrants the diskettes on which the program is furnished
to be free from defects in materials and workmanship under normal use
for a period of ninety (90) days from the date of delivery to you as
evidenced by a copy of your receipt. The duration of any implied
warranties on the diskettes is limited to the period stated above. ACI's
entire liability and your exclusive remedy as to the diskettes (which is
subject to you returning the diskettes to ACI or an authorized dealer
with a copy of your receipt) will be the replacement of the diskettes or,
if ACI or the dealer is unable to deliver a replacement diskette, the
refund of the purchase price and termination of this Agreement.
SOME STATES DO.NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS SO THE ABOVE LIMITATION MAY
NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS WHICH
VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY

IN NO EVENT WILL ACI BE LIABLE FOR ANY DAMAGES, INCLUD-
ING LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAM-
AGES ARISING FROM THE USE OF THE PROGRAM OR ACCOM-
PANYING MATERIALS, HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IFACIOR
AUTHORIZED DEALER HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE LICENSE
FEE REFLECTS THIS ALLOCATION OF RISK. SOME STATES DO
NOT ALLOW LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

GENERAL

This Agreement will be governed by the laws of France. In any dispute
arising out of this Agreement, ACI and you each consent to the
jurisdiction of the courts of France.

Use, duplication or disclosure by the U.S. Government is subject to
restrictions stated in paragraph (c) (1) (i) of the Rights in Technical Data
and Computer Software clause at 252.227-7013.

Licensor: ACI, 5 Rue Beaujon, 75008 Paris, France

This Agreement is the entire agreement between us and supersedes
any other communications with respect to the program and accompa-
nying materials.

If any provision of this Agreement is held to be unenforceable, the
remainder of this agreement shall continue in full force and effect.

If you have any questions, please contact: ACl Customer
Service, (33) 1 42 27 37 25 or write us at the above address.

SIGN AND MAIL THE REGISTRATION CARD TODAY.
Return of the registration card is required to receive any
product updates and notices of new versions or enhance-
ments.

All trade names referenced are the trademark or registered trademark
of their respective holder.

4th DIMENSION, 4D Runtime, 4D, and the abstract 4 logo are trade-
marks of ACIUS, Inc. and ACI.
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4th DIMENSION is a powerful relational database for Apple’s family of
Macintosh computers.

You can use 4th DIMENSION to manage your own data. In the User
environment, you can

m  add, modify, and update records

m search and sort records

m create reports and labels from information in the database

m import and export data between 4th DIMENSION and other
applications

With 4th DIMENSION, you can enhance conventional data management
tasks with

m a powerful Layout editor that works like a full-featured drawing
program to let you add object-oriented graphics to your layout

m the capacity to store graphics in databases
®m a password access system to protect sensitive data
m graphing functions that let you generate a variety of business graphs

m the capability to create custom applications from 4th DIMENSION
with custom menus, dialog boxes, and buttons t

m a full-featured programming language

4th DIMENSION’s flexibility and power make it ideal for a complete range
of information management tasks. Novice users can quickly create
databases and begin managing their data. Experienced users without
programming experience can customize their databases with

4th DIMENSION’s development tools. Experienced developers can use

4th DIMENSION’s powerful programming language to add sophisticated
features and capabilities to their databases.

When you design a custom database with 4th DIMENSION, all the
components of the Macintosh user interface are at your disposal. You can
add menus, dialog boxes, buttons, and windows to enhance your databases
and allow users to be more productive.

PREFACE  Xiii
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About This Manual

This manual serves as a reference to 4th DIMENSION’s User environment
and provides detailed descriptions of the operations that you can perform
in this environment.

The manual that complements the information in this guide is the

4th DIMENSION Design Reference. It provides a description of

4th DIMENSION’s Design environment. Refer to it when you are designing
and building a database.

Using This Manual

Use this manual in conjunction with the other manuals in the
4th DIMENSION package.

The 4th DIMENSION Quick Start and the 4th DIMENSION Tutorials lead
you through lessons where you create and use a 4th DIMENSION database.
These lessons give you first-hand experience and help you become
familiar with the concepts and features of 4th DIMENSION.

The 4th DIMENSION Design Reference describes the environment where
you create databases.

The 4th DIMENSION Language Reference describes the language
associated with 4th DIMENSION, and it includes an introduction to
programming with 4th DIMENSION.

The 4th DIMENSION Utilities Guide describes the utilities included with
4th DIMENSION, such as 4D Tools.

The 4th DIMENSION Glossary and Master Index provides the glossary that
defines terms and an index for all 4th DIMENSION documents.

To use the 4th DIMENSION User Reference effectively:
m  Go through the 4th DIMENSION Quick Start and Tutorials.

m Create a database, referring to the 4¢th DIMENSION Design Reference
when you need to review a process or explanation.

m  Enter and manipulate data in your database, referring to this manual
when you need to review a process.

m  Refer to the 4th DIMENSION Glossary if you encounter an unfamiliar
term.
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USER ENVIRONMENT BASICS

This chapter provides an overview of the User environment and discusses
several special topics relating to the User environment. The special topics
are

using the User environment menus

choosing single-user or multi-user mode

s
[
m specifying the location of temporary files
® opening a remote data file

m

entering and using a password-protected-database

The User Environment

The User environment is where you work with your data. It contains a
complete set of generic tools to manage information. You can import or
export data; enter, modify, or delete records; conduct searches and sorts;
and create and print reports, labels, and graphs.

In the User environment, you use layouts to enter and manage data. Each
file in your database has an input layout and an output layout. Any layout
can be used as either an input or output layout.

When a layout is used as an input layout, it displays one record at a time.
An input layout is used to enter, view, and modify information. When a
layout is used as an output layout, it displays several records in the form of
a list. An output layout is used to browse through records, select records,
and print a selection of records. You can switch from one file to another
and change the input and output layouts you work with.

When you manage data, you select the group of records you want to work
with. This group of records is called the current selection. The current
selection can be one, some, or all records in a file. Each file in your
database has its own current selection.

The current selection is an important concept in 4th DIMENSION. The
most common data management operations are performed on the records
in the current selection. These operations include

m sorting records
m viewing and modifying individual records
updating records using a formula

printing a report

generating labels

CHAPTER 1: USER ENVIRONMENT BASICS 3



graphing data

exporting records

The User environment includes complete facilities for designing reports
and labels and for graphing data. The Quick Report, Label, and Graph
editors let you create printed output without using a layout.

User Environment Menus

This section gives a brief description of the User environment menu bar.
The User environment menu bar contains the following menus

File
Edit
Use
Enter
Select
Report
Special

You can add custom menus to the User environment menu bar.

Custom menus appear to the right of the Special menu. You use

custom menu bars to customize the User environment to simplify complex
or time-consuming tasks.

The File Menu

New Database...
Open Database...

Import Data...
Export Data...

Choose File/Layout... 3F

Page Setup...
Print...

Quit %0

The File menu contains items for performing standard file operations. It
contains the following menu items:

New Database displays the create-file dialog box. Use it to create and
name a new database. It first closes and saves the database that is
currently open.

Open Database displays the open-file dialog box. Use it to open an
existing database. It first closes and saves the database that is currently
open.

Import Data displays the Import Data dialog box. Use it to import
data into the current file. For a discussion of importing and exporting
data, see Chapter 12.

Export Data displays the Export Data dialog box. Use it to export the
current selection.

Choose File/Layout displays the Choose File/Layout dialog box. Use
it to change files or layouts. For a discussion of choosing files and
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m  Page Setup displays the Page Setup dialog box for the printer that you
have specified in the Chooser.

m  Print first displays the “Choose print layout” Dialog box. Use it to
print reports using a layout. For a discussion of printing reports using
layouts, see Chapter 7.

m  Quit closes and saves the database you are working with and returns
to the Finder.

The Edit Menu

The Edit menu contains the standard Macintosh Edit menu items:

® Undo
Hndn W m Cut
Cut ®H s Copy
Copy *®C
Paste sl m Paste
Clear
Seloct Bl %R m  Clear
Show Clipboard " Select All

m  Show Clipboard

These menu items perform the standard Macintosh editing operations.
Standard Macintosh editing operations are covered in the user’s guide that
came with your Macintosh.

You can use these commands when managing data. For more information,
see Chapter 3.

The Use Menu

The Use menu contains the names of the three 4th DIMENSION
environments. Use it to switch from one environment to another. It
contains the following items:

m  Design switches to the Design environment.

Design ®Y
vUser #U

Buntime Wi

m User indicates that you are in the User environment.

m  Runtime switches to the Runtime environment. The Runtime menu
item is dimmed if you have not created custom menus.

0 : : —_ : . e

71 Note: The Design menu item is dimmed if you do not have access privileges
to this environment. See Chapter 8 of the 4th DIMENSION Design Reference
for information on access privileges.

CHAPIER 1: USER ENVIRONMENT BASICS 5



New Record #EN

Modify Record #M

The Enter Menu

Apply Formula...

vEnter in List 3,

The Enter menu contains items used for entering and modifying data.
It contains the following items:

New Record displays a blank input layout for data entry. Choose New
record to begin entering data.

Modify Record displays a highlighted record using the current input
layout. Modify Record is dimmed if no records are highlighted.
Modify Record is also dimmed if you are using an input layout.

Apply Formula displays the Formula editor. Choose Apply Formula
to make changes to the current selection of records using a formula.

Enter in List toggles the Enter in List mode. When in the Enter in List
mode, you can enter and modify data using an output layout. When the
Enter in List mode is active, a check mark appears next to the item.

For information on entering, modifying, and updating records,
see Chapter 5.

The Select Menu

Show All #6
Show Subset #®H
Search Editor... *®S

Search by Layout... 3L
Search and Modify...
Search by Formula...

Sort Selection... T

Sort File...

The Select menu contains items for selecting, searching, and sorting
records. It contains the following items:

Show All displays all the records in the file you are working with
using the output layout. Show All is dimmed if you are using an input
layout.

Show Subset is used to select the group of records that is highlighted
in the output layout. Show Subset is dimmed if no records are
highlighted or if you are using an input layout.

Search Editor displays the Search editor. The Search editor is a
general-purpose search editor that you can use to carry out many
types of searches.

Search by Layout displays the current input layout as a search-by-
example window.

Search and Modify displays the Search and Modify dialog box.
Use Search and Modify to search on the indexed fields in the current
file. The first record that is located by the search is displayed in the
input layout.

Search by Formula displays the Formula editor. Use Search by
Formula when you need to write a formula to search records.

Sort Selection displays the Sort editor. Use Sort Selection to sort
the current selection.
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m Sort File displays the Sort editor. Use Sort File to sort all the records
in a file permanently.

For a discussion of selecting and searching, see Chapter 4. For a
discussion of sorting, see Chapter 6.

The Report Menu

The Report menu contains menu items that display the Quick Report,
Label, and Graph editors. You use these editors to create a wide range
of printed output.

The Report menu contains the following menu items:

m  Quick displays the Quick Report editor. Use it to create and print
tabular reports.

Quick... ¥R
Labels... 3J m Labels displays the Label editor. Use it to create and print labels.
Greph-, Wk m Graph displays the Graph editor. Use it to graph data.

The Quick Report, Label, and Graph editors are discussed in
Chapters 8, 9, and 10, respectively.

The Special Menu

The Special menu contains three miscellaneous menu items:

= Edit Input ASCII Map displays the “Edit an ASCII Map for
Edit Output ASCIT Map... importing” dialog box. Use it to create and choose an ASCII map
Edit Input ASCII Map... . ) )
for importing data.

m  Edit Output ASCII Map displays the “Edit an ASCII Map for
exporting” dialog box. Use it to create and choose an ASCII map
for exporting data.

Execute Procedure... ¥E

m  Execute Procedure displays the “Execute procedure” dialog box.
Use it to execute a global procedure from the User environment.

ASCII maps are discussed in Appendix A. The Execute procedure
command is discussed in Chapter 11.

Custom Menus

Using the Layout editor in the Design environment, you can associate a
menu bar with a layout. Whenever the layout is used as an input layout,
the menus on the custom menu bar are appended to the User
environment’s menu bar.

CHAPTER 1: USER ENVIRONMENT BASICS 7



Standard menus
Custom menu

[ (3 ‘File Edit Use Enter Select Report Special JHTiTges
| || sales Report

Inventory Report

Figure 1-1 Customer List
User environment menu bar with custom menu

You use the menus and menu items on the custom menu bar for
specialized functions. For example, a custom menu might contain menu
commands that display custom search dialog boxes, print reports, or
import data using a special format. You use custom menu bars as you
would use menus and menu items in any application.

See Chapter 7 of the 4th DIMENSION Design Reference for more
information on designing custom menu bars. Chapter 4 of the

4th DIMENSION Design Reference contains information on associating
menu bars with layouts.

Choosing Single-User or Multi-User Mode

Any 4th DIMENSION application will run in multi-user mode. In multi-
user mode, several people can access the same data file at the same time.
When one user makes a change to the database, that change becomes
available to all other users immediately. 4th DIMENSION automatically
handles possible conflicts that arise when two users try to modify the same
record at the same time.

To run in multi-user mode, you will need a file server, a network, and
4th DIMENSION or 4th DIMENSION Runtime for each Macintosh on the
network.

ﬁ Note: You must use a separate licensed 4th DIMENSION or 4th DIMENSION
Runtime for each user of the database. The license agreement prohibits the
use of any one copy of 4th DIMENSION or 4th DIMENSION Runtime by more

than one user or more than one computer.

To operate a database in multi-user mode:

m Install 4th DIMENSION or 4th DIMENSION Runtime on each
Macintosh on the network. The run-time version allows a user to
manage information in the Runtime environment but not make any
changes to the design of the database.

m Install a file server and a network to physically link the Macintoshes.
For optimal performance, use a high-speed network such as EtherNet.

m  Copy the data file to the file server.
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m  Make copies of the structure file and install one copy on each local
hard disk (the hard disk connected to each Macintosh) or copy the
structure file to the file server.

ﬁ Note: For optimal performance, install separate copies of the structure file
on each local hard disk.

When each user first launches 4th DIMENSION, he or she must instruct
4th DIMENSION to operate in multi-user mode.

To choose multi-user mode, follow these steps:

Double-click the application icon or the structure file and hold down the
mouse button. ’

The dialog box shown in Figure 1-2 is displayed.

) Multi-user

Database Access
!> @ Single-user —‘

Location of temporary files

@ In the 'data file' folder
3 In the structure folder
2 In 4th Dimension folder

[ cancel | [ ok ]

Figure 1-2
Single- or multi-user dialog box

Click the Multi-user radio button.

After this option is selected, the copy of 4th DIMENSION or

4th DIMENSION Runtime will remain in multi-user mode until it is
changed. You will not need to hold the mouse button down while
launching 4th DIMENSION unless you want to switch to single-user mode.

Specifying the Location of Temporary Files

While 4th DIMENSION is running it sometimes creates and uses temporary
disk files. These disk files are automatically deleted from your hard disk
when you quit 4th DIMENSION and return to the Finder.

The dialog box shown in Figure 1-2 also lets you specify the location of
temporary files. If you are using 4th DIMENSION in single-user mode and

CHAPTER 1: USER ENVIRONMENT BASICS 9
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Contacts Contacts.data

Contacts f

are using one hard disk, the location of the temporary files probably does
not matter. If you are using multi-user mode, you will probably want to
use the local hard disk for temporary files. 4th DIMENSION can access the
local hard disk faster than it can access the file server. Placing the
temporary files on the local hard disk improves performance.

If you have installed your data file on the file server and the structure file
on the local hard disk, choose either the “4th DIMENSION folder” or
“Structure file” options.

The selected option remains in effect until you change it.

Opening a Remote Data File

A 4th DIMENSION database consists of two disk files, a structure file and a
data file. The structure file contains all or your specifications for the design
of the database. The data file contains your data and any indexes you build.
When you create a new database, 4th DIMENSION creates a folder and
places the structure and data files in the folder. The folder is given the
name you assigned to the database, followed by an “f”. The data file is
also given the same name, followed by “.data”. For example, if you named
a database Contacts, the folder will be named Contactsf, the structure file
will be named Contacts, and the data file will be named Contacts.data.

You can open a database by double-clicking the structure file.

4th DIMENSION will look in the folder that contains the structure file for a
data file with the same name. If it finds it, it will open the data file
automatically.

4th DIMENSION does not require that the structure and data files have the
same names, be in the same folder, or be on the same disk. You can move
either the structure or data files to new locations. The new location can be
on the same hard disk, on a different hard disk connected to the Macintosh,
or a hard disk on a network. If you separate the data file from the structure
file, you will need to tell 4th DIMENSION where you have moved it.

If you move the data file, 4th DIMENSION will prompt you for the location
of the data file the first time you open the structure file. It will display the
“Open data file” dialog box shown in Figure 1-3.
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Figure 1-3

“Open data file” dialog box

Select the data file by double-clicking the filename or by selecting the
filename and clicking the “Open data file”” button.

On subsequent launches of the database, 4th DIMENSION will “remember”
where the data file is (technically, 4th DIMENSION stores the pathname of
the data file). The Open Data file dialog box will not be displayed unless
you move the data file to a new location.

Entering a Password-Protected Database

4th DIMENSION’s Design environment includes a comprehensive
Password access system. The access system is used to selectively grant
access to parts of a database. Access can be granted to files, layouts, menu
items, and procedures. The access system can be used for either the User
or Runtime environments.

The Password access system is based on a set of passwords. Each user of
the database is given a password. To enter a password-protected database,
you must first type your password.

To enter a password-protected database, follow these steps:

Open the database by double-clicking the structure file or 4th DIMENSION
icon or by clicking either icon and choosing Open from the File menu.

4th DIMENSION displays the “Enter password” dialog box shown in
Figure 1-4.
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Figure 1-4
“Enter password” dialog box

The “Enter password” dialog box lists all users who have been given
passwords.

Click your name and type your password. If you do not have a password,
click Guest and click the OK button. A guest is granted limited access to
the database.

The password system is case-sensitive; be sure to type the password using
the correct upper- and lower-case characters.

When you type, a small icon is displayed in place of each character.

If you typed the password correctly, you are given the level of access to
the database that was specified when the access system was designed. If
you typed the password incorrectly, the Macintosh will beep.

Using a Password-Protected Database

After you have entered a password-protected database, you can use any
part of the database to which you have been granted access. Unless you are
the designer of the database, you will not have access to the Design
environment.

The access system is used to grant access to files, layouts, menus, and
procedures. If you try to use a part of the database to which you do not
have access, a dialog box similar to the one shown in Figure 1-5 will be
displayed.



s Your password does not allow you to use
this layout.

Figure 1-5
“Access denied” alert box

Click OK and use another part of the database.

CHAPTER 1: USER ENVIRONMENT BASICS 13
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CHOOSING FILES AND LAYOUTS

In a 4th DIMENSION database, you store information in files. Each file
stores a different type of information. For example, a Contacts database
might have one file that stores information about people and another file
that stores information about companies. Each record in the [People] file
contains information about one person. This file can have fields for

First Name, Last Name, Home Address, City, State, Zip code, and

Home telephone number. In the [Company] file, each record could
contain information about a particular company. The [Company] file
might have fields for Company name, Address, City, State, and Zip code.

In the User environment, you use one layout at a time. Each layout
belongs to a particular file. You can switch between files whenever you
need to work with data in another file. For example, while entering data
into the [Company] file, you may need to look up a home telephone
number stored in the [People] file.

Each file can have as many as 32,000 layouts attached to it. You can
create different layouts to meet specific needs. For example, different
report forms can be used for different types of reports, and different
layouts can be used for different monitor sizes. In the User environment,
you can switch between files and layouts at any time.

A default input and a default output layout is specified in the Design
environment for each file in the database. These layouts are used unless
you specify different layouts in the User environment. There are two
ways of choosing files and layouts:

m  Use the Choose File/Layout menu item in the File menu.

m Use the “List of files” window.

These two methods can be used interchangeably. They carry out exactly
the same functions. The Choose File/Layout menu item is more convenient
for choosing layouts because it displays a thumbnail picture. The “List of
files” window is more convenient for switching files or for switching
layouts when you don’t need to view a thumbnail.

You can choose a new file or a new layout while you are using either an
input or an output layout. Your choices are used immediately.

ﬁ Note: If you switch to the Design environment, your choices are saved with
the database; otherwise they are temporary changes.
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Using the Choose File/Layout Dialog Box

To choose a file and layout using the Choose/File Layout dialog box,
follow these steps:

Choose the Choose File/Layout item from the File menu.

The Choose File/Layout dialog box shown in Figure 2-1 is displayed.

Choose File/Layout...

Employees Degorimasts

&

Layout names

Departments il 2. ]
Data entry vt ]

l- Input Layout | [] Output

| Done |

/h‘[

[ #rmpang |

Figure 2-1
Choose File/Layout dialog box

It lists the names of the files in the database.

Select a file by double-clicking a filename.

4th DIMENSION displays a list of layouts that belong to that file.

If the selected layouts are satisfactory, click Choose to make your change.
If you also want to change the input or output layouts, proceed to step 3.

The O and / next to layout names indicate the default output and default
input layouts, respectively. The letter B next to a layout name indicates
that the same layout is used as both the input and output layout.

Click a layout name on the expanded list.

4th DIMENSION displays a thumbnail sketch of the selected layout in
the area on the right side of the dialog box.

If the selected layout is already a default layout, a check appears in the
Input or Output check box.

Click the Input or the Output check box to change layouts.

Or click both check boxes to specify the layout as the current layout for
both input and output.
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Click Choose to change the current file and input or output layouts.

Or click Done to return to the layout you were using at the time you
chose Choose File/Layout.

Your changes remain in effect until you change them again.

Using the “List of files” Window

To choose a file using the “List of files” window, follow these steps:

If the “List of files” window is not visible, hold down the Command key
and press the Space bar to bring it to the foreground.

The “List of files” window, shown in Figure 2-2, is displayed.

== List of files
ees
ments

[I]1(0] pepart

= ]

Figure 2-2
The “List of files” window

If necessary, use the scroll bar or the size box to view the names of
additional files.

Each filename in the “List of files” window is accompanied by two
icons that represent output and input layouts. The left icon (I) represents
input layouts; the right icon (O) represents output layouts.

Click the name of the file in the “List of files” window.

4th DIMENSION displays the current selection for that file using the
output layout.

To change layouts, follow these steps:

Click either the input or output icons next to a filename in the “List of
files” window and hold down the mouse button.

A pop-up menu appears. It lists the names of all the layouts belonging
to the selected file. Figure 2-3 shows a pop-up menu.
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Empl Report
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Figure 2-3
Pop-up menu in “List of files” window

An underline in the pop-up menu indicates the current input or output
layout.

Select the name of the layout you want to specify as the current input or
output layout.

To hide the “List of files” window, follow this step:

m  Press Command—Space bar.
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USING INPUT AND OUTPUT LAYOUTS

Input and output layouts provide a “view” into your database. You use
layouts to enter, view, modify, and print information. This chapter covers
basic skills in managing information using input and output layouts.
These skills are used whenever you work with data—entering new
records, modifying existing records, and working with a list of records.

Any layout can be used as either an input or an output layout.

When a layout is used as an output layout, it displays several records in
a scrollable list. You use an output layout to

m scroll a list of records
m highlight a subset of records

m double-click a record to display it in the input layout

The Enter in List mode changes the way in which you use an output
layout. When in the Enter in List mode, the fields in the layout become
enterable. You can also enter or modify records using the output layout.
But you cannot highlight or double-click records when in Enter in List
mode.

When a layout is used as an input layout, it displays one record at a time.
You can enter and modify information, move from one field in the layout
to another, and move from one record to another. An input layout usually
has buttons that you use to

m save a new record to disk or save modifications to an existing record
m cancel changes to a record

m navigate from one record to another

=

delete a record

Using Output Layouts

An output layout lists records. Although any layout can be used as an
output layout, most output layouts have these features:

m Each row is a record
m Each column is a field or a variable

m  Each column is labeled at the top of the window

A typical output layout is shown in Figure 3-1on the following page.
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Title Bar = Employees: 57 of 57 =E
First Narne Last Name Start Date Salary Title DEPT CODE‘G
Number of records Biff Davis 1/2/80 43780 Salesperson SAL
in selection Shirley Ransome 1/11/80 26040 |Supervisor MAaN
Lance Walfram 1/14/80 27300 | Technician PROD
Number of Dennis Hanson 1/14/80 40520 |Manager ADM
P Lydiz Yernon 1415480 26370 |Supervisor SAL
records n flle G ] YEnable 715720 43520 |Engineer ART
Jim Borrell 1/22/30 26540 |Salesperson SAL
Brysan Pfaff 1/22/80 26440 |Secretary ADM
Elevator KEmsg Hetzer 72370 26270(CIEFE SAL
Kathy Forbes 1/28/80 18840 |Secretary ART
Scroll bars Garth Harmmons 276780 50100 |Salesperson SAL
Tary Srith 277780 E5000 [Engineer TRAN
Frederic E=ll 2714780 £0400 |Director MAN
Alan Hull 2720480 41460 |Supervisor FROD
Shirley Nalevanko 2421480 41050 |Designer DES
Marlys ‘Wilzon 2/27/80 36500 |Supervisor ADM
Gearge Liyle 2/28/30 47300 Salesperson SAL
Srneldorf Garbando /6480 19610 |Clerk TRAN

Figure 3-1
An Output layout

An output layout can be used in either of two modes, the “normal” mode
and the Enter in List mode. In the normal mode, you can scroll, highlight,
and double-click records. In normal mode, fields are not enterable.

In Enter in List mode, the fields on the output layout are enterable. You
can add new records or modify existing records.

There are four basic skills used in working with output layouts:
m  scrolling

® highlighting

m  double-clicking

m cntering and modifying

Scrolling

The output layout has standard horizontal and vertical scroll bars. You can
scroll records by clicking either arrow, clicking the scroll bar, or by
dragging the elevator. If the output layout has more fields than can be
displayed in the window, you can scroll horizontally using the scroll bar at
the bottom of the window.

Highlighting

You highlight a record by clicking it. You can highlight one record, two or
more adjacent records, or two or more records that are not adjacent. After
highlighting records, you can perform operations such as selecting or
deleting them.



To highlight one record, follow this step:

m Click a record displayed in the output layout.

The record you clicked is highlighted.

To highlight several adjacent records, follow these steps:

Click the first record you want to highlight.

Hold down the Shift key and click the last record you want to highlight.
All the records between the first and last ones you clicked are highlighted.
To highlight several non-adjacent records, follow these steps:

Click the first record you want to highlight.

Hold down the Command key and click another record.

Continue clicking records while holding down the Command key.

Each record you click is highlighted.

To highlight all records, follow this step:

m  Choose Select All from the Edit menu.

All records displayed in the output layout are highlighted.

If you want to highlight all records in the file, choose Show All from the
Select menu before choosing Select All from the Edit menu.

Double-clicking

You can view a record in the input layout by double-clicking it in the
output layout. When you double-click a record, the output layout is
replaced by the input layout. The record you double-clicked is displayed in
the input layout ready for modification.

Entering and Modifying

You can add and modify records in an output layout using the Enter in List
mode. The output layout is especially useful for modifying a few adjacent
records because several records are displayed on the screen
simultaneously.

You can only enter or modify fields in the current file. You cannot enter
into variables, fields from other files, or included layouts.

CHAPTER 3: USING INPUT AND OUTPUT LAYOUTS
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Using Input Layouts

When you are in Enter in List mode, you can
m use the Enter key or the New Record menu item to add a new record

® use the Tab or Return key to move from field to field

Tabbing out of a field or clicking on another field will save your changes.

Emplogees: 78 of 78 EBEI
Ermploy |Marme Cepartrnent Mare Salary A7
£9 [Georgina LINDAY ceounts Fayable $28,324
&5 [Karla KLUTZ $23,500
47 [Anna FREDRICKSON
20(Mary SMITH $26 650

S |Mathan ANDERSON
24 [Richard CHAVED
E7 |Cindy KANE
&1 [Sarmuel C IRRYING

$31,200
$22,000

54 | Julie HANSON $23,000
43 Maria C DENMNISON $17,950
endall Mewton $38,550

ally Smith $35,567

9 |Susan R Fennel Adriinistration $25,320
rederich Burgess Adrinistration 28,000

20 |Jonathan Patel Adrrinistration $31,100
26 [Wanda MATTHEWSON Administration $25,260
1 |Tom DAVIS Administration $28,500
T4 [Fredi Prince Art Department $35,287
S [Hildenard Hill Art Denartrent $7% A7R

Figure 3-2
Enter in List mode with a field highlighted

o) T : : :
71 Note: Enter in List is available only for single-user use and only in the User
environment.

When using the Enter in List mode, the highlighting and double-clicking
functions are disabled.

To enter and modify fields using an output layout, follow this step:
m  Choose Enter in List from the Enter menu.

The fields in the output layout become enterable. A check mark appears
next to this menu item to indicate that you are in Enter in List mode.

To leave Enter in List mode, choose Enter in List from the Enter menu
again.

The input layout is the primary tool for entering and modifying data.
Although any layout can be used as an input layout, most input layouts
have the following elements:
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one or more enterable areas, into which data can be entered
a button for accepting the record

a button for canceling the record

buttons for navigating from one record to another (e.g., First record,
Last record, Next record, Previous record) and buttons for navigating
from one page to another (e.g., First page, Last page, Next page,
Previous page)

m a button for deleting the record

You use these elements to manage information. You use enterable areas
to enter values into the database. You use the accept button to save a new
record or save changes to an existing record. When you accept a record,
you request 4th DIMENSION to add the new record (or your changes to
an existing record) to the database stored on disk.

You use the Cancel button to discard changes you make to an existing
record or discard a new record. If you press the Cancel button while
entering a new record, 4th DIMENSION does not add the record to the
database. If you press the Cancel button while modifying an existing
record, 4th DIMENSION ignores any changes you have made. The record
you were modifying is not affected by your changes.

You use navigation buttons to move from one record to another. When
you press a navigation button, 4th DIMENSION accepts the record you
were adding or modifying before displaying a new record.

You use the Delete button to permanently delete a record from the
database.

Layout Templates

The Layout editor in the Design environment has templates that are used
to generate input layouts automatically. All templates generate layouts
containing one or more enterable areas and a default control panel or a
set of buttons. They differ in the way the Accept, Cancel, Navigation,
and Delete functions are represented.

There are two types of templates. One type places a control panel to the
left of the enterable areas and the second type places a row of buttons at
the bottom of the screen. Example layouts based on the two types of
standard templates are shown in Figure 3-3.
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Figure 3-3
Simple input layouts

Enterable Areas and the Data Entry Order

You enter data into enterable areas. An enterable area can be either a field
or a variable.

When entering or modifying data, you move from one enterable area to
another in a consistent order. This order is called the data entry order.
Every enterable area into which you can type a value is included in the
data entry order. Also, Boolean fields (shown as radio buttons or check
boxes), included layouts, and areas that accept pictures are included in the
data entry order.
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Thermometers, rulers, dials, scrollable areas, and pop-up menus can also
be used to enter data. These objects, however, are not included in the data

entry order. They are selected by clicking.

ﬁ Note: The data entry order can be changed in the Layout editor. The data

entry order for a particular layout may not necessarily move from left to right
or top to bottom. See Chapter 3 of the 4th DIMENSION Design Reference for
information on changing the data entry order.

To move forward in the data entry order, follow this step:

m Press the Tab key or the Return key.

ﬁ Note: In a Text field, pressing Return ends the paragraph you are writing and
moves the insertion point to the next line in the field. Use the Tab key to move
forward in the data entry order.

To move backward in the data entry order, follow this step:
m Hold down the Shift key and press Tab.

To select any enterable area, follow this step:

m  Click on the area or tab into it using either Tab or Shift-Tab.

Accept Button

When you are satisfied with your entry, you can accept the record. When
you accept a record, you tell 4th DIMENSION to add the record to the
database.

To accept a record, follow this step:
m Click the Accept button.

Or press the Enter key.
4th DIMENSION adds the record to the database.

In multi-page layouts, the fields on all the pages are part of the same

record. In a multi-page layout, pressing the Accept button on any page
saves the entire record. Similarly, pressing the Enter key while on any
page saves the entire record.

ﬁ Note: 4th DIMENSION updates the data file stored on your hard disk at
regular intervals. You can specify this interval using the Preferences dialog
box in the Design environment. See Chapter 1 of the 4th DIMENSION Design
Reference for more information on setting preferences.
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Cancel Button

If you decide you don’t want to add the record to the database or save
modifications to an existing record, you can cancel the entry. When you
cancel an entry, the data you entered is not saved. If you were modifying
an existing record when you canceled, 4th DIMENSION discards the
modifications. No changes are made to the record stored on disk.

To cancel a record, follow this step:

m  Click the Cancel button.
Or press Command—period.

4th DIMENSION discards any data you have entered or modified for
that record and displays the output layout.

Navigation Buttons

A layout often contains buttons for moving from one record to another.
4th DIMENSION automatically disables navigation buttons when
appropriate. The four navigation buttons are:

m First record
m Last record
m Previous record

m Next record

Clicking any of these buttons accepts the current record and then moves
to another record.

Page Navigation Buttons

An input layout can consist of more than one page. Multi-page layouts
have navigation buttons for moving between pages. The four page
navigation buttons are:

m  First page
m Last page
m Previous page
m  Next page

Clicking a page navigation button displays another page in the layout
but does not accept or cancel the record.

ﬁ Note: Not all the page navigation functions appear on the standard layout
templates. You can add the remaining functions using the Layout editor in the
Design environment.
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An input layout can have a Delete button. It is used to delete the record
being displayed. Deleting a record cannot be undone; before deleting the
record, 4th DIMENSION displays a dialog box in which you can confirm
or cancel the deletion.

To delete a record, follow this step:

m Press the Delete button.

Editing Data

While you are entering or modifying data, you can edit the values you
enter before accepting the record. Highlight the value you want to edit and
use standard Macintosh text editing techniques. You can use the Cut,
Copy, and Paste commands in the Edit menu to modify any entry. Select
text by dragging.

If you make a typing error, you can press the Delete key to backspace over
the incorrect characters. You can also choose Undo from the Edit menu.
4th DIMENSION will undo your last action.

For more information on data entry, see the section “Entering and
Modifying Data” in this chapter.

Interrupting Data Entry

When you are using an input or output layout, you can choose any menu
item that is not dimmed. For example, you can conduct a search, print a
quick report or labels, print a report using a layout, or graph data. If you
choose a menu item while you are in the process of entering or modifying
a record, 4th DIMENSION displays an alert box asking you whether you
want to accept or discard the record being entered, or cancel the menu
selection and return to the record being entered.

Figure 3-4 shows the “This record has been modified” alert box.

This record has been modified, would you
like to save it?

[[ Save ]][Don't Saue] [ cancel |

Figure 3-4
The “This record has been modified” alert box

You can proceed with the menu selection and then add or modify
records at a later time.

2
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Entering and Modifying Different Types of Data

Each field in a layout has a field type that dictates the kind of data you can
enter. Most fields are generally numeric or alphanumeric; you enter data in
these fields simply by typing. Other types of fields accept data only in
particular formats.

Alpha, Numeric, Date, and Time fields can have display formats
associated with them. When you Tab out of a field with a display format,
4th DIMENSION applies the format to the data you entered. For more
information about each data type and the available formats, see Chapter 3
of the 4th DIMENSION Design Reference.

Scripts and layout procedures can be used to process data as it is entered.
When you tab out of a field, a script or part of a layout procedure is
executed. Scripts or layout procedures might be used to validate data,
update the contents of other files, or compute values of variables. For more
information about scripts and procedures, see Chapter 4 of the

4th DIMENSION Design Reference.

Entering Data in an Alpha Field

An Alpha field can contain alphanumeric characters (letters and numbers),
punctuation marks, and special characters (*, %, @, {, and so forth). The
maximum length of an Alpha field is set in the Design environment. If you
type more characters than the maximum, the extra characters are truncated.

An entry filter can be associated with an Alpha field. An entry filter
validates the values that you type on a character-by-character basis. It
affects how you can enter and edit data. See the section “Entering data into
a field with an Entry Filter” in this section for more information.

Entering Data in a Numeric Field

4th DIMENSION supports three types of numeric fields: Integer, Long
Integer, and Real. Integer and Long Integer fields store only whole
numbers. If you enter a decimal point and numbers to the right of the
decimal, the number will be truncated.

Integer fields accept numbers between £32,767. Long integer fields accept
numbers between +2,147,483,647. A Real field contains double-precision
real numbers, between £1E1022.

Numeric fields do not store formatting characters such as the dollar sign or
the comma (Real number fields store the decimal place). If you enter a
formatting character, it is ignored. To format a numeric field, use a format.
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Entering Data in a Text Field

A Text field functions like a text processor. It can hold up to 32,000
characters. Typically, text fields are used for entering long blocks of text
such as notes or comments. A Text field can have a vertical scroll bar.

A Text field provides basic text editing features: scrolling; word wrap
within the field; double-clicking to select words; support of the arrow
keys; and standard cut, copy, and paste operations. You can type a Return
into a Text field. If you press the Return key, the insertion point moves to
the next line.

You cannot use tabs in a Text field. If you press the Tab key while in a Text
field, the insertion point moves to the next enterable area in the data entry
order.

4th DIMENSION lets you paste text files into a text field. For example,
you can copy the contents of a letter written in a word processor into a
Text field. You will, however, lose the word processor’s formatting.

Entering Data in a Date Field

. A Date field accepts any date entered in a standard month/day/year format
 (MM/DD/YYYY). 4th DIMENSION stores dates between the year 100 AD
and the year 32,767. You can enter the year using either two or four digits.
If you use two digits, 4th DIMENSION assumes the date is in the 20th
century.

The month, day, and year can be separated by any character except a
number. Some example date entries are shown in Table 3-1.

Table 3-1

Example date entries

Entryﬁ - 7 - ~ Result
6:23:84 6/23/1984
6/23/84 6/23/1984
623 1984 6/23/1984
6/23/1492 6/23/1492

Entering Data in a Time Field

A time can be entered in 12- or 24-hour format. The time is stored in
hours/minutes/seconds format (HH:MM:SS). The entries can be separated
by any character except a number. During data entry, 4th DIMENSION will
attempt to interpret partial entries. For example, the entry “1 p” is
interpreted as 1:00 PM. The “p” tells 4th DIMENSION to add 12 hours to
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Marquee

the value you enter. The entry “6 a” is interpreted as 6:00:00.
If you enter “36 3 7, 4th DIMENSION interprets the entry as “36 hours 3
minutes 7 seconds.” Table 3-2 shows some example time entries.

Table 3-2
Example time entries

Entry ~ Result
I1a 11:00:00
3p 15:00:00
3h 11m 3:11:00
23:43 23:43:00
6:00:05 6:00:05
2386 23:08:06

Entering Data in a Boolean Field

A Boolean field takes on one of two values, TRUE or FALSE. A Boolean
field is displayed as either a check box or a pair of radio buttons. Boolean
fields are included in the data entry order. When a Boolean field is
selected, the Boolean field is outlined by a marquee (a border that
surrounds the field).

[ current Member

s |

Health Plan
Q Pink Cross @ Horne Farm

Figure 3-5

Two Boolean fields: check box and radio buttons

4th DIMENSION interprets a checked box as a yes (TRUE) value; an
empty box is a no (FALSE) value. If a Boolean field is displayed as a
pair of radio buttons, the value of the Boolean field is TRUE if the first
radio button is checked. If the second radio button is checked, the
value of the field is FALSE.

To enter a value for a Boolean field displayed as a check box,
follow this step:

m  Click the check box to enter the value of TRUE for the field.
Or press the Space bar to toggle between checked and unchecked.

Or type “Y".
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To enter a value for a Boolean field displayed as a pair of radio buttons,
follow this step:

m Click on either radio button.
Or press the Space bar to toggle between the two radio buttons.
Or use the keyboard equivalents.

The first letters of the labels for the radio buttons can be used as keyboard
equivalents. For example, if the radio buttons are labeled “Male” and
“Female”, you can use the “M” and “F” keys. Also, the “Y” and “N” keys
can be used to enter values. Typing “Y” is equivalent to clicking the first
radio button; typing “N” is equivalent to clicking the second radio button.

Entering Data in a Picture Field

A Picture field accepts graphics created in Macintosh graphics
applications. The size of the graphic is limited only by available memory.

A Picture field can accept bit-mapped or object-oriented graphics in the
PICT or PICT2 formats. If you created a graphic in a PostScript-based
application, that application may provide an option for copying or saving
the image in PICT format. See that product’s manual for more information.

To enter a picture into a Picture field, follow these steps:
Copy the picture to the Clipboard.
Select the picture field into which you want to paste the graphic.

Select the field either by clicking or by using the Tab key. A selected
picture field is inverted.

Choose Paste from the Edit menu.

Graphics stored in a Picture field appear in one of three display formats.

®  Truncated: The boundaries of the Picture field act like a “cookie
cutter” on the graphic that you paste into the field. The picture is
centered in the field.

4th DIMENSION saves the entire picture, even if only a portion is
shown on the input layout.
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Figure 3-6

Truncated picture field

m  Scaled to Fit: In this display format, 4th DIMENSION resizes the
graphic to fit the dimensions of the picture field. Because
4th DIMENSION may compress or eiongate the graphic to fit the
dimensions of the Picture field, the picture may appear distorted.

'

Figure 3-7
Scaled to Fit picture field

s On Background: In this display format, the graphic pasted into the
layout is transparent—any object behind the pasted graphic is visible

Sice  through the graphic. When a picture is displayed in this format, you

(e,z

—

can move the pasted picture around the inside of the picture field by
dragging it. 4th DIMENSION remembers the position of the picture
after you save the record.

Picture field

Pasting a
graphic in the
Picture field

Figure 3-8
On Background picture field
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You can change the contrast of the picture with the background.
To change the contrast of a background picture, follow these steps:

After you paste the picture into the field, double-click the field.

4th DIMENSION displays the “Choice of mode™ palette, shown in

Figure 3-9. /%.‘.,{
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Figure 3-9 - . >
“Choice of mode” palette J) 3 x4 OK

Select one of the contrasts from the palette.

4th DIMENSION applies the new contrast to the picture.

Entering Data in Fields with Attributes

Attributes that are attached to fields affect the way in which

4th DIMENSION processes data. See Chapter 3 of the 4th DIMENSION
Design Reference for information on field attributes. This section discusses
how attributes affect data entry.

Entering Data in a Mandatory Field

Mandatory fields contain data that is essential to the database, such as
fields that uniquely identify each record in a file. Any field type can be
given the Mandatory attribute.

If a field is mandatory, you must enter a value for that field before the
record can be accepted. If you don’t enter a value into a Mandatory field,
4th DIMENSION will display an alert box when you try to accept the
record. After you dismiss the alert box, you can then enter a value into the
Mandatory field and accept the record. 4th DIMENSION will not let you
accept the record until you have entered a value into the Mandatory field.

Figure 3-10 shows the Mandatory field alert box.
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s The field Last Name in file [Employees] is
mandatory.

Figure 3-10
Mandatory field alert box

Entering Data in a Unique Field

A field with the Unique attribute accepts only entries that uniquely identify
each record in the file. The Unique attribute might be assigned to the key
field of a file, such as social security number or invoice number.

When you enter a value into a Unique field and press the Tab key,

4th DIMENSION determines whether the entry is, in fact, unique. If you
enter a value that already exists, 4th DIMENSION displays an alert box that
informs you that the value has already been entered. You can then enter a
new value.

s This key already exists for the field
SSNumber.

Figure 3-11
The Unique field alert box

0 ' .
71 Note: You cannot enter more than one record with a null value
in a Unique field.

Entering Data in a Field with a Validation Range

A validation range specifies the minimum and maximum values that may
be entered in an area. If you enter a value above the maximum value or
below the minimum value, 4th DIMENSION will display an alert box when
you press the Tab key. The alert box will tell you the minimum or
maximum value you have exceeded.



B The number must not be greater than
200000.

Figure 3-12
The Validation range alert box

Entering Data in a Field with an Entry Filter

An Entry Filter is a data validation tool. It examines each character as it is
typed. As you type, 4th DIMENSION compares each character you enter to
the set of characters specified by the entry filter. If you type an invalid
character, 4th DIMENSION rejects the character; it is not shown on screen.
Invalid characters are disregarded and valid characters are displayed
normally. This method of data validation differs from other methods,
which accept or reject the entire entry.

The Cut, Copy, and Paste functions do not work normally if an Entry Filter
is associated with an enterable area. You cannot cut or copy more than one
character and you cannot paste into a field with an entry filter.

An entry filter can also specify the maximum number of characters that
can be entered in a particular field. When you enter the last character, the
insertion point automatically moves to the next enterable area. You do not
need to press the Tab key to move to the next field in the data entry order.

Entering Data in a Field with a Choice List

Moving the insertion point into a field with a Choice List displays a list
that you can choose a value from. The list is displayed in the Choice List
window. An example Choice List window is shown in Figure 3-13.
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& File Edit Use Enter Select Report Special
Entry for Em Choices for Title e
o
Employee Informpiester
Engineer
A Manager
A ijll 74 Last Name  |Ransome Salesperson
Secretar
First Name [Shirle
d Technician k
Z Start Date Fri, Jan 11,
Salary $36,040.00
[:l]elete ] Title Supervisor [
[ Cancel ] [ Modify ]
]
I [l

Figure 3-13
Choice List window

A choice list is often used to limit entries to specific values and prevent
misspellings. For example, a Title field in a Personnel database can be
associated with a list of all the job titles in that company.

Some choice lists contain items that are linked to other lists. If you
choose an item that is linked to another list, 4th DIMENSION replaces
the list with a new list of items in the Choice List window.

To enter data using a choice list, follow these steps:
Display the Choice List window by selecting the field.
Click the value you want to enter.

Or if the list is sorted, type an entry. The list will scroll, trying to match
the value you type. Press Return to select a highlighted value.

Or use the Up and Down Arrow keys to highlight values on the list.
Press Return to select a highlighted value.

Press Tab to cancel the entry.
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Entering Data in an Area with a Modifiable
Choice List

A Choice List can be designated as modifiable. If so, you can
m add items to the list

®  modify items on the list

m delete items

= sort the list alphabetically

ﬁ Note: Lists cannot be modified while you are using 4th DIMENSION in
~ multi-user mode.

To modify a choice list, follow this step:
m  Click Modify.

The “Items in list” dialog box, shown in Figure 3-14, is displayed.

Items in list

Manager
Salesperson [ Insert
|

Supervisor | Append )| [ cancel |

Technician

[ Delete ] [ ok ]

[crerk |

Figure 3-14
The “Items in list” dialog box

The dialog box lists the items on the list. An entry area beneath the list
is used to enter or modify items. The buttons on the right side of the dialog
box are used to modify the list.

To add items to the end of the list, follow these steps:
Click Append.

4th DIMENSION highlights the empty area below the last entry in the
list and places the insertion point in the entry area.

Type an item.

As you type, the new item appears in the list of menu items.
To insert an item in the list, follow these steps:

Click an item on the list.

Click Insert.
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4th DIMENSION creates an entry area above the item you clicked
on and places the insertion point in the entry area.

Type an item.
As you type, the new item appears in the list of menu items.

To modify an item, follow this step:

m Click the item you want to modify and then modify the item in
the entry area.

To delete an item, follow this step:

m Click the item in the list, then click Delete.

4th DIMENSION deletes the item from the list and removes the
space it occupied.

To sort the list, follow this step:
m Click Sort.

4th DIMENSION sorts the list alphabetically. Sorting the list allows
you to select an item by typing.

Click OK to save the modified list and close the dialog box.
Click Cancel to discard any changes you made and close the dialog box.

Entering Data in a Field with an Excluded Values
or Required Choice List

A list can also be used to exclude values from a field or require that

only certain values be entered. Excluded lists contain values that are not
acceptable. If you type a value that appears on an excluded list, an alert
box will be displayed indicating that the value you typed is not allowed.

Entering Data in an Included Layout

Some of your layouts may contain included layouts—Iayouts from other
files or subfiles that are nested within the current layout. The current
layout in this context is sometimes called the parent layout. Included
layouts provide a way for you to add data to a subfile or to a related file
without switching files or layouts. You can enter data into an included
layout in either of two ways.

s Multi-line: You can enter multiple records directly into the included
layout area on the parent layout. An included layout that supports
entry in the multi-line mode is called enterable.

e ——————
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m Full-page: You can also enter data using an input layout belonging
to the other file or subfile. An included layout that supports this entry
method is called double-clickable.

Either of these ways of entering data are specified using the Layout editor
in the Design environment.

An included layout can be both enterable and double-clickable. If an
included layout is both enterable and double-clickable, you can enter data
directly in the included layout or through an input layout belonging to the
file or subfile.

If the included layout is enterable, you can enter or modify data directly
into the included layout. '

To enter data using the included layout, follow these steps:
Select the included layout area by clicking it or by Tabbing to it.

Press Command—Tab.

ﬁ Note: A button that creates a new record or subrecord in the included layout
can also be used. For more information, see the description of the Add to

Included button Action in Chapter 4 of the 4th DIMENSION Design Reference.

4th DIMENSION creates a new record or subrecord and selects the first
empty field in the included layout.

[T}

Entry for Departments E=——————11=

(Ihler ) Departments

Department Name lDesign

Manager [Ms. Mclish

First Mame Last Name

I

Delete
[ Cancel

3]

) &

Figure 3-15
A selected field in an included layout

Enter data in the included layout. Use the Tab key to move through
the data entry order within the included layout.

The new record in the included layout is saved when you tab out of the
included layout or click another enterable area in the parent layout.

Di#3
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If the included layout belongs to a subfile, the new subrecord is not
saved until you accept the parent record.

If you want to create another record, press Command—Tab within the
included layout.

Click any field in the parent record to return to the parent layout.

If the included layout has a full-page layout associated with it, you can
enter data directly into the input layout of the file or subfile without
closing the input layout you are entering.

To enter data using a full-page layout, follow these steps:

Double-click anywhere in the included layout area below the last record
displayed in the included layout. 4th DIMENSION displays the input layout
for the subfile or related file. If the included layout is not double-clickable,
double-clicking does nothing.

ﬁ Note: You can also use a button to display the full-page layout.
For more information, see the description of the Open Included button
action in Chapter 4 of the 4th DIMENSION Design Reference.

Enter data in the full-page layout as you would in any other input layout.

Press Enter or click Accept to add the new record to the database and
return to the parent layout.

To modify a record using a full-page layout, follow these steps:

Double-click the record you want to modify. 4th DIMENSION displays
the record using the full-page layout. If the included layout does not have
a full-page layout associated with it, double-clicking does nothing.

Modify the record.

Press Enter or click Accept to save your modifications and return to
the parent layout.
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SELECTING RECORDS

You select records in your database to access information that you want to
use. For example, you might search a database of contacts to look up the
telephone number of a person you need to call or to select the people to
whom you want to send product information.

In 4th DIMENSION, the group of records you have selected is called the
current selection. The current selection can be any subset of records in a
file—from no records up to all the records.

You can change the current selection by
m selecting all records

® selecting a subset of records

m searching the database

The current selection is the group of records on which other operations are
carried out. For example, you can

m sort the current selection

m perform a global update

m print the records using a layout

m print the records using a Quick Report
®m print labels

m  graph data

m  modify or delete records

m export records

In other words, creating a current selection is the first step in many other
data management operations.

The title bar of the output layout tells you how many records are in the
current file and how many records from the file are in the current selection.
In multi-user mode, the title bar tells you the number of records in the
current selection.
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[ % File Edit Use Enter Select Report Special |
E% Employees: 9 ofl S"c)c5FGG EE

First Name Last Name Start Date Salary Title DEFT CODE
Name of file Shirley Ranzome 1411780 $36,040 [Supervisor MaN
ance Walfram 1/14/80 $27,300 [Technician PROD
Dennis Hansan 1/14/80 $40,520 [Manager ADM
Number of records Lydia Vernon 1/15/80 $36,570 |Supervisor SAL
in Selecﬁon Andy enable 115480 $4%,520 |Engineer ART
i Eorrell T7ZZ780 $36,540 |Salesperson SaL
Ed Esber 1/23/80 $16,270 [Clerk ShL
Number Of Frederic Eell 214780 $25,200 |irector MAN
I’eCOI’dS in file Shirley Nalevanko 2421480 $41,050 |Designer DES

Select
Show All

i

$61 #

Search Editor...
Search by Layout... #L
Search and Modify...

Search by Formula...

Sort Selection...
Sort File...

Figure 4-1

A current selection of records in a file

The standard control panel in an input layout shows the number of records
in the current selection and the number of the record being displayed.

Each file in a multiple-file database has its own current selection. In
multiple-file databases, changing the current selection in one file can
change the current selections in related files, provided the relations
between the files are automatic. For example, in a database consisting of
related [Employees] and [Departments] files, a search in the [Employees]
file might change the current selection in the [Departments] file. For more
information on automatic relations, see Chapter 2 of the 4th DIMENSION
Design Reference.

Selecting All Records

When an output layout is used to display records, you can set the current
selection equal to all the records in the current file.

To select all records, follow this step:

m Choose Show All from the Select menu.
Show All is dimmed if you are using an input layout.

All the records in the current file become the current selection.



Selecting a Subset of Records

You can create a new current selection directly in the output layout by
highlighting records and defining the highlighted records as the new
current selection.

To create a Subset, follow these steps:
Highlight one or more records.

Highlighting records is discussed in the section “Using Output Layouts” in
Chapter 3.
Choose Show Subset from the Select menu.

4th DIMENSION displays the new current selection in the output layout.
Figure 4-2 shows the process of creating a Subset.
[ ® File Edit Use Enter JEYIEIR

Report Special

i Show Rl
First Name Last Name Show Subset DEPT CODE
To Johnso = i
e — Search Editor... 965 | DES

Search by Layout... 3L

Search and Modify...

Search by Formula...

Sort Selection... ®T
Bryan Pfaff sort File... cretary ADM
Kathy Forbes 1/28/20 $18,240|Secretary ART
Garth Hammons 2/6/80 $50,100 |Salesperson SAL
Mary Smith 2/7/80 $26,500 |Engineer ADM
Alan Hull 2/20/30 $41,460 [Supervisor PROD
Marlys Wilson 2/27/80 $36 500 [Supervisor ADM
George Lyle 2/28/80 $47,900 |Salesperson SAL
Smeldort Garbando 3/6/80 $192,610|Clerk TRAN

Figure 4-2
Creating a Subset

Searching the Database

Searching is one of the most common database operations. A search is
often the most convenient way to select the records you want to work with.

The term searching refers to finding a group of records in the database
based on the contents of one or more fields. You perform a search by
specifying a search condition. A search condition is a set of instructions
that tell 4th DIMENSION which records to include in the new current
selection.
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A search condition always has three elements: field name, comparison
operator, and value. The field name is from the current file or a related file.
The comparison operator tells 4th DIMENSION how to compare the
contents of the field to the value you specify (equal to, greater than, less
than, and so forth). The value is the value to which each record is
compared.

Suppose you want to see all the records for employees with salaries greater
than $30,000. The search condition you would use is “Salary is greater
than 30000.” Salary is the field, “is greater than” is the comparison
operator, and “30000” is the value.

When you search a database, 4th DIMENSION compares the contents of
the field in the search condition to the value you specify. The new current
selection is made up of records that meet the search conditions. The new
current selection can be no records, one record, a group of records, or all
the records in the file.

You can do a search while you are using either an input or an output
layout. If you do a search while you are using an input layout, the first
record in the new current selection is shown in the input layout. You can
view, modify, or print the record. If the new current selection consists of
more than one record, you can move through the records using the
navigation buttons (Previous record, Next record, First record, Last
record). If you modify a record before pressing a navigation button,

4th DIMENSION will save the modifications to disk.

In multiple-file databases, you can search on fields from other files,
provided that an automatic relation between the files has been established.
For more information on automatic relations, see Chapter 2 of the

4th DIMENSION Design Reference.

If you do the search while using an output layout, the new current
selection is displayed in the output layout.

Indexed and Sequential Searches

4th DIMENSION can carry out searches very quickly if it has an ordered
list of the records to work from. An ordered list is called an index. An
index is associated with a particular field and is stored on disk as part of
the data file.

A search that is done without an index is slower because the program must
start at the beginning of the file and examine each record until it finds the
records you are looking for. To be sure that it has found all the records you
are looking for, it must examine every record in the file sequentially. This
process is called a sequential search.
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If an index is available, the program “knows’ where the target records are
located. If you are searching for everyone whose last name is Smith, the
program will know where in the file the Smiths are located. Thus, it
doesn’t need to examine every record in the file.

A good analogy to an index is a card catalog in a library. The card catalog
is an alphabetized list of all the books in the library. Each record in the
catalog contains information about where the book is physically located. If
you are looking for a particular book, it would be very inefficient to
conduct a sequential search of the library’s entire holdings. It is much
faster to consult the card catalog, obtain the location of the book, and then
search the particular shelf on which the book is stored.

When you are designing a database, you should index the fields that you
are likely to use often for searching. As you enter or import records,

4th DIMENSION automatically updates all indexes. When you do searches,
4th DIMENSION automatically uses indexes if they are available.

Comparison Operators

When you write a search condition, you tell 4th DIMENSION how to
compare the value you specify to the contents of the database. For
example, the search condition, “Last Name equals ‘Smith’” uses the “is
equal to” comparison operator. It tells 4th DIMENSION to compare the
values in the Last Name field to the string “Smith.”

The following comparison operators are available:
m isequal to {
m is not equal to

m is greater than

m is greater than or equal to

m s less than

m is less than or equal to

m contains

m does not contain

4th DIMENSION also has a wildcard character (@) that substitutes for one
or more characters in the value being searched for. You use the wildcard
character to do a “Begins with” search. For example, to find everyone
whose last name begins with “S,” you would use the search condition,
“Last name is equal to S@.” That is, you use “S@” as the value to be
searched for. Using the wildcard character with the “is equal to”
comparison operator is equivalent to a “Begins with”” comparison.
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@ The @ symbol is used throughout 4th DIMENSION as the wildcard
_character, and is not limited to search conditions.

The wildcard character can be used only with Alpha or Text fields.
Simple and Compound Searches

You can search on one or more fields. A search on one field is called a
simple search. For example, the search “Last name equals ‘Smith’” is a
simple search. In this case, 4th DIMENSION examines the contents of one
field when searching the database.

A search on two or more fields is called a compound search. When you do
a compound search you combine separate search conditions using a
conjunction operator. The conjunction operator tells 4th DIMENSION how
to combine the results of the individual searches. There are three
conjunction operators:

m  And finds all the records that meet two conditions simultaneously. For
example, the search condition “Find all the employees who work in
the engineering department and who make over $50,000” will find the
records of only those engineering employees who make over $50,000.

m  Or finds all the records that meet either of two conditions. For
example, the search condition “Find all the employees who work in
the engineering department or who make over $50,000” will find the
records of all the people in the engineering department, as well as all
the people who make over $50,000 regardless of the department they
work in.

= Except is the equivalent of “not.” The search condition, “Find all the
engineers who make over $50,000 except those who have worked in
the department more than ten years” will exclude the engineers with
ten years of seniority.

The conjunction operators let you create compound search conditions,
such as “Find the salespeople in New York and who have commission
rates in excess of 30 per cent and who had sales volume less than
$200,000.” 4th DIMENSION will find all the New York salespeople who
may be getting high commissions for low volume sales.

Examples of the uses of comparison and conjunction operators are given
for each search method.

52



Using the Search Menu ltems

4th DIMENSION provides several powerful methods for searching a
database. You can use any of the search methods to create a search
condition. Records that meet the search condition become the new current
selection.

You can choose any search method when you are using either an input or
an output layout.

~Zd - The Select menu provides four search menu items. Each menu item
ow

Show Subset 2H displays a different search dialog box or a search window. They differ in
Search Editor... %S the types of searches they carry out and the way in which the current
Search by Layout... L . 5 . .

search and Modify... selection is displayed.

Search by Formula...

The four search menu items represent four different search methods:

Sort Sglection... ®T
e, m  Search Editor displays the Search editor. It is a general-purpose
search dialog box that can be used to perform simple or compound
searches. You can specify compound search conditions using the
< conjunctions. You can also save search conditions to disk and restrict
RERCT the search to the current selection.

= Search by Layout displays the current input layout for use as a search
window. You specify a search by typing the values to be searched for
in the areas corresponding to the fields to be searched. You can specify
compound search conditions by typing values into more than one area.

m  Search and Modify displays a dialog box that includes only the
indexed fields in the current file. You specify a search by typing the
value to be searched for into the areas corresponding to the fields to be
searched. You can specify compound search conditions by typing
values into more than one area. The Search and Modify command
always displays the results of the search using the input layout.

m  Search by Formula displays the Formula editor. You use the Formula
editor to construct a search that uses a formula in the search condition.
For example, you can use Search by Formula to search on the last
three digits of a six-digit part number. A valid formula returns a
Boolean expression (TRUE or FALSE).

Search Editor

The Search editor is a general-purpose editor that can be used to create
simple or compound search conditions. The Search editor lets you create
compound searches linked with the And, Or, or Except conjunctions. For
example, you can use the Search editor to perform a search for all
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employees who are over 60 years old or who have an income
in excess of $45,000.

The Search editor gives you the choice of searching through the current
selection of records, or all the records in the file. The other three search
methods always search the entire file.

The Search editor lets you save search conditions to disk. You can open
search conditions when you want to repeat the search.

The Search editor remembers your last search conditions. You can edit
these conditions or clear them and enter a new search condition.

The Search editor allows you to search on any field in the current file and
any fields in related files, provided the relations to the other files are
automatic. You can also search on subfields in the current file or subfields
in related files.

If your database includes subrecords, you can use subfields in your search
conditions. A search on subrecords creates a new current selection

of parent records, not subrecords. This group of parent records contain at
least one subrecord that meets the search condition. However, the search
does not remove the other subrecords from the parent record. All
subrecords stay attached to their parent records.

Suppose a database for employees includes a subfile for information about
employee children. The fields in the subfile, called subfields, are First
Name, Middle Name, and Last Name. To find all the employees with a
child named John involves searching the subrecords for John in the First
Name subfield. 4th DIMENSION finds all the parent records with at least
one subrecord with the name “John” in the first name subfield. The
selection is not just the subrecords themselves.

If your database includes related files, you can include fields from related
files in your search. A search on a field in a related Many file works like a
search of subrecords. The new current selection in the One file consists of
all records that are related to at least one record in the Many file that meet
the search condition. Searches on related files are always sequential, even
if the field being searched on is indexed.

For example, if employees are stored in the One file and children are
stored in a related Many file instead of a subfile, a search for employees
with children named John would produce the same current selection

of employees.

Figure 4-3 shows the Search editor.
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Criteria area

Fleld area rﬂ- - iz equal to
Last Name y iz not equal to r,:\
First N iz greater than -
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[ save.. | |: Load... } [ cancel | ( 0K ]
Figure 4-3

The Search editor
The Search editor contains the

m Criteria area that displays the search conditions as you create them
or after you load them from a disk file.

m Field area that displays the names of the fields in the current file
or other files. Indexed fields are shown in boldface.

m  Operator area that displays a list of comparison operators.

m  Conjunction area that contains three radio buttons that correspond to
conjunction operators you can use to join several search conditions
into a compound condition.

m Value area that is where you enter values to search for.

m Search in selection check box that lets you perform a search only on
the records in the current selection. If Search in selection is not
checked, the entire file will be searched.

m Search editor buttons that you use to save your search criterion, load
other conditions from disk, cancel the search, or perform the search.

To create a search condition, follow these steps:

1. Choose Search Editor from the Select menu.
Show HII » #’l}

4th DIMENSION displays the Search editor, highlighting the portion of the

ea 1 D . . ~ . . .
Searel bif Lagoile. 1 Criteria area where a field name will appear. A blinking marquee around
Search and Modify... x
Seared: by Foadte the Field area shows where you can select a field name.

sortsetection.. #7112, Click a field name to use in the search condition. If the field you want to
search on is in a related file, click a cycle arrow above the field area to
display the fields from other files.
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4th DIMENSION displays the field name in the Criteria area and highlights
the area where the comparison operator will appear. The blinking marquee
moves to the Operator area. Figure 4-4 shows a field name in the Criteria
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area.

Search Editor

Last Marne _

« -+ qual t
Last Name 4 ot equal to

First Name ater than

Start Date reater than or equal to
Salary than

Title than or equal to
SENumber contains
[Yalue |

[] Search in selection

[ save.. | [

Load... |

Cancel

( 0K

Figure 4-4

Field name in Search editor

Click a comparison operator.

4th DIMENSION adds the operator to the Criteria area and advances
the highlight to the area where a value will appear. The marquee moves

to the Value area.

Search Editor

Last Narne iz equal to

- iz equal to
Last Name i equal to ) And
First Name ter than -
Start Date iz greater than or equal to 3 0r
Salary iz less than ~
Title than or equal to () Except
SSNurmber cantains
Yalue 1

[ Search in selection

[ save.. | [

Load... | [ Cancel

Figure 4-5

Operator in the Criteria area

Type the value to search for. In a Text or Alpha field you can use the
wildcard character, @, at the end of the value to request a “Begins with”

search.




USER

If the field you selected is associated with a Choice List, 4th DIMENSION
will display the list and prompt you to select a value. If the field you
selected is a Boolean field, 4th DIMENSION will display a pair of radio
buttons. If the field you selected is a subfile, a window listing the subfields
will be displayed.

If you want to create a compound search condition, click one of the
conjunction buttons (And, Or, or Except) and repeat steps 2 through 4.

Figure 4-6 displays a compound search condition.

Search Editor

Last Narne iz equal to Srith
And Salary iz greater than or equal to 25000

+ iz equal to
Last Name iz not equal to \-D And
First Name iz greater than
Start Date iz greater than or equal to Cx or
Salary is less than
Title is less than or equal to ) Except
SENumber contains
Value Jemith

[J Search in selection

[ sawe.. | [ Lead.. | [ cancel | [ 0K |

Figure 4-6
A compound search condition

ﬁ Note: When you build a compound search condition, 4th DIMENSION
evaluates the conditions in the order in which they appear in the Search
editor, i.e., from top-to-bottom. That is, there is no precedence among
the conjunctions. Thus, if you have used more than two simple search
conditions in building the compound condition, the order in which you

enter search conditions can affect the results of the search.

As you build the search condition, you can modify existing parts of
the condition by clicking the area you want to change and selecting or
typing a new entry.

You can remove the search condition by choosing Clear from the Edit
menu. In a compound search condition, you can remove one line of
the condition by choosing Cut from the Edit menu.

To save the search condition as a disk file, click Save and enter a
filename in the create-file dialog box.

You do not need to save your search condition.
Click OK to perform the search.

Click Cancel to quit the Search editor.
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Search by Layout

The Search by Layout method is a convenient way to perform most
searches. In this search method, you use the current input layout to enter
values to search for. You can search only on fields in the current file.
Search by Layout performs both indexed and sequential searches.

You can enter a value in a single field or you can specify compound
searches by entering a value in more than one field. If you do a compound
search, Search by Layout uses the And conjunction operator.

Figure 4-7 shows a simple search using Search by Layout.

[EE=—=—=—=— Entry for Employees ===z
' ©
Employees

Cancel

Last Mame  [Smith

First Name |

Start Date
Salary =

Title |

Figure 4-7

Example Search by Layout window

The Search by Layout window shown in Figure 4-7 is only an example.
You can control the appearance of the Search by Layout window by
designing input layouts in the Layout editor.

The comparison operators shown below can be used in the Search by
Layout dialog box. To use the “is equal to” comparison operator, simply
enter the value to be searched for in the appropriate field. If another logical
operator is needed, precede the value with one of the following signs.

Table 4-1
Comparison operators available in Search by Layout

Comparison operator Sign Example

is not equal to # #Marketing
is greater than > >30000

is greater than or equal to >= >=30000

is less than < <30000

is less than or equal to <= <=30000
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Sort File...
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You can request a “Begins with” search by placing the wildcard character
@ after the value to be searched for. For example, the value “Apple@”
requests all records that begin with “Apple” in the specified field.

In Search by Layout, you can create a compound search condition by
typing values into more than one field. If you enter a compound search
condition, the And conjunction is assumed (e.g., “Last Name is equal to
Smith and Salary is greater than or equal to $25,000”). Figure 4-8 shows a
compound search using Search by Layout.

Entry for Employees =E|
o
S
Employees
Last Name  |Smith
First Name |
Start Date
Salary »>25000 =
Title |
]
K] [
Figure 4-8

Example compound search

To use Search by Layout, follow these steps:
Choose Search by Layout from the Select menu.

4th DIMENSION displays the input layout for the current file as a
search-by-example window. If the layout uses the standard control panel,
the panel is replaced with a Search control panel. If a custom input layout
is used, the buttons on the layout replace the standard control panel.

Enter a value to search for in a field. For example, to find records for
everyone with the last name “Smith,” you would enter “Smith” in the
Last Name field.

To use a comparison operator, precede the value by the comparison
operator.

To do a compound search, enter values in additional fields.

4th DIMENSION uses the And conjunction if you enter values for more
than one field. For example, if you enter “Smith™ in the Last Name field
and “>25000" in the Salary field, you are specifying a search for all
persons with the last name Smith and also have a salary of more than
$25,000. See Figure 4-8.
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Click the Search button or press the Enter key to begin the search.
(Depending on the input layout used as the template, the Search button
may be labeled differently.)

To cancel the search, press the Cancel button or press Command-period.

Search and Modify

Search Editor...
Search by Layout...

Search by Formula...

*®S
L

Search and Modify...

Sort Selection...
Sort File...

®T

The Search and Modify method is intended for quickly finding and
modifying records. It, therefore, only supports searches on indexed fields.
You can specify compound search conditions, but you cannot specify
comparison operators. The “is equal to” operator is used for all searches.

After it has found a record or selection of records, the first record is
displayed in the input layout for modification. After you accept the record,
you are returned to the output layout.

Because the Search and Modify dialog box only displays the contents of
indexed fields in the current file, you cannot use Search and Modify if you
need to search on fields from related files, on unindexed fields, or on
subfields.

To use Search and Modify, follow these steps:
Choose Search and Modify from the Select menu.

4th DIMENSION displays a dialog box containing the names of indexed
fields in the current file and corresponding criteria entry areas.

Figure 4-9 shows a typical Search and Modify dialog box.

Employees
[Last Name [Smith i
[First Name | ]
(Department Code | )
[Frevicus page | [Nent Page ] [ cCancel | [ 0K |

Figure 4-9

Search and Modify dialog box

If there are more indexed fields than 4th DIMENSION can display in the
Search and Modify dialog box, 4th DIMENSION generates as many pages
as it needs. Use the Previous Page and Next Page buttons to display
additional pages.
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Click the entry area for the first field to search on.

Enter a value in the area. For example, if you want to modify records that
contain “Smith” in a Last Name field, the dialog box might look like the
one shown in Figure 4-9.

If desired, select additional entry areas and enter other values to search on.
Search and Modify uses the And conjunction if you enter values for more
than one field. Figure 4-10 shows a compound search condition.

Employees
(Last Name ISrmth )
|First Name ] J
f_l)enartment Code ]ENG )
Prapigus Page ] NeRrt %’ag;zc-] [ Cancel ] 0K

Figure 4-10
A compound search condition using Search and Modify

For Alpha fields, you can also use the wildcard character, @, to perform a
“Begins with” search. For example, entering “Apple@” in the Company
area requests a search of all companies whose name begins with Apple.

Click OK.

4th DIMENSION performs the search, sets the current selection, and
displays the first record that meets the search criterion in the input layout.

Modify the records using standard Macintosh text editing methods.

Click the navigation icons to move to other records in the current
selection. 4th DIMENSION saves each record as you move to another
record.

Or click the Accept button or press the Enter key to accept the modified
record and return to the output layout.

Click Cancel to end the editing session—you don’t have to modify every
record in the current selection.

4th DIMENSION displays the output layout.
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Search by Formula

Use Search by Formula to find records based on the results of a
calculation. You use the Formula editor to write the formula. You can use
any function in the language or any user-written function in a formula.

Search by Formula is useful for writing search conditions that involve
operations such as

m performing operations on alphanumeric strings and making
evaluations on them

m  searching on the results of date computations

m searching on the results of arithmetic computations
Here are some examples of the uses of Search by Formula.

The following formula is used to search for records in which the last seven
characters of the Phone number field is equal to “2524444.”

Substring (Phone number;4,7) ="2524444"

The following formula finds people born on the current date regardless of
year:

(Day of (Current date) = Day of (Birthdate)) &
(Month of (Current date) = Month of (Birthdate))

The following formula divides annual sales by cost of living and finds
records whose calculated value is greater than 1,000:

(Annual Sales / CostOfLiving) > 1000

The formula must be a Boolean expression. That is, it can only return two
values, TRUE or FALSE. For example, the formula

Annual Sales / CostOfLiving

is incorrect because it returns a numeric value, not TRUE or FALSE.

You can only write formulas that are one logical line long. That is, you
can’t press the Return key and write a second line. The editing area,
however, will wrap to the next line if the statement is too long.

You can save formulas to disk and load saved formulas into the Formula
editor.

See the 4th DIMENSION Language Reference for more information on
using the language.
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Figure 4-11 shows a search formula written in the Formula editor.

(Current date-Start Date)>30

Keywords +* = Routines
+ il Last Mame L+ CREATE SET
- First Narne CREATE SUBRECORD
* — Start Date rrent date
/ Salary rrent password
- Title rrent time
= umber Date

[ Load... | [ save.. | | Cancel | [[ 0K
Figure 4-11

The Formula editor

For a detailed description of the Formula editor, see the section
“Global Updates™ in Chapter 5.

To use Search by Formula, follow these steps:

1. Choose Search by Formula from the Select menu.

Show All #06
Show Subses S . i
s ! 2. Use the Formula editor to build a formula.
Search Editor... ®S
S :3;:19:;'@'... * Or click Load to retrieve an existing formula from disk.
Sort Selection... T If you click Load, 4th DIMENSION displays an open-file dialog box and
Sort File...

asks you to select a file. When you load a file, it replaces any formula that
appears in the Apply Formula editor.

The formula must equal either TRUE or FALSE for every record.
3. If you want to save a new formula in a disk file, click Save.

4th DIMENSION displays a create-file dialog box and asks you to name a
file to store the new formula.

Enter a filename and click Save to save the formula.
4. Click OK to execute the search.

4th DIMENSION closes the Formula editor and evaluates the formula for
each record in the file. If the formula is TRUE, the record is added to the
current selection.

Click Cancel to cancel the search and return to the input or output layout.
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ADDING, MODIFYING, UPDATING, AND
DELETING RECORDS

This chapter discusses the major operations you perform when working
with data. This includes

m adding records

= modifying records
® updating records
m deleting records

After you create a database in the Design environment, you can switch to
the User environment and begin entering data. To add records to the
database, you need only to create a file, one or more fields, and one or
more layouts. You can then switch to the User environment, begin entering
data, and return to the Design environment to add files, fields, layouts, or
make any other changes you like.

After adding records to your database, you usually will need to modify the
information. If you need to modify one or more records, you can use one
of the search methods described in Chapter 4 to display the records. You
can then modify the records using either the input or output layout.

Sometimes you need to make exactly the same change to a group of
records in a file. This is called a global update. In 4th DIMENSION, you
can update the contents of a file automatically—without having to make
the change to each record by typing the new values.

You may also find that you need to delete one or more records. You can
delete a record if you discover the record is outdated or not relevant. If the
record is needed but the values stored in the record are no longer correct,
you should modify the record rather than deleting it.

You can delete the current record from an input layout or you can delete a
subset of records in the current selection using the output layout.

CHAPTER 5: ADDING, MODIFYING, UPDATING, AND DELETING
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Adding New Records

You can add records using either an input or an output layout. For a
description of basic skills you use to work with input and output layouts,
see Chapter 3.

To add a new record using an input layout, follow these steps:
Choose New Record from the Enter menu.

You can choose New Record while you are using either an input or an
output layout.

4th DIMENSION displays a blank input layout and places the insertion
point in the first enterable area in the layout.

Enter data into the first enterable area.

Press Tab.

4th DIMENSION moves the insertion point to the next enterable area.
Enter data into this area.

Press Tab.

Repeat the process of entering data into each enterable area until all data
for that record has been entered.

When you have finished entering data and are satisfied with the values you
have entered, you can accept the record.

Press the Enter key or click the Enter button on the input layout to accept
the record.

By accepting the record, you are requesting 4th DIMENSION to add the
record to the database stored on disk.

A new blank input layout is displayed. Repeat the data entry process until
you want to stop.

When you finish entering data, click the Cancel button on the layout or
press Command-period when the next blank record is displayed. Either of
these actions displays the output layout.

To add a new record using an output layout, follow these steps:

Choose Enter in List from the Enter menu.

ﬁ Note: Enter in List is not available in multi-user mode.

The fields in the current7ﬁ~le become enterable. Yoﬁ caﬁnot enter into
variables, fields from other files, or included layouts.
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2. Choose New Record from the Enter menu or press the Enter key.

An insertion point appears in the first field below the last record displayed
in the output layout.

3. Type in the field, and use the Tab key to move through the fields
for that record.

Any data validation techniques that are attached to the fields on the layout
will be used when you select those fields. For example, a field with a
Choice List will display the Choice List when you tab into the field.

4. Press Enter to save the new record and create a new blank record.
Or click a field in another record.
4th DIMENSION accepts the entries in the record you added.

5. Choose Enter in List from the Enter menu to leave the Enter in List mode.

Modifying Records

You modify records when you need to update information or you discover
that the information originally entered is incorrect. Before modifying a
group of records, select the records to modify as the current selection. You
can use a search to select records for modification or select the records
after highlighting them in the output layout. For information on selecting
records and searching the contents of a database, see Chapter 4.

You can modify records using either the input or output layout. The output
layout is convenient for modifying a group of records because several
records are displayed at the same time.

To modify records using an input layout, follow these steps:

e 1. Highlight a record in the output layout and choose Modify record from the
New Record #EN
odifu Record Enter menu.

Apply Formula... Or double-click the record.

Enterinlist %, 2. Select fields and edit, replace, or delete the values. See Chapter 3 for more

information on editing data.

3. After you have made your changes, click Enter to accept the modified
record and return to the output layout or click a navigation button
(Previous record, First record, Last record) to accept the record and move
to the next record in the current selection. Clicking a navigation button
moves between records in the current selection.

At any time, you can click Cancel or press Command—period to return to
the output layout.
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To modify records using an output layout, follow these steps:
Choose Enter in List from the Enter menu.
The fields in the output layout become enterable.

A check mark appears next to the Enter in List menu item to indicate that
the Enter in List mode is active.

Select a field and edit, replace, or delete the value.

When the Enter in List mode is active, double-clicking selects the word or
number rather than displaying the record in the input layout.

ﬁ Note: When you are in Enter in List mode, you can select Modify Record from
the Enter menu to modify the record in the input layout.

Type the new text and press Tab or Return. This saves your changes to
that field and selects the next field.

Continue modifying fields as needed.

Click a field in another record in the output layout to modify another
record.

Or press Enter to accept the modified record and create a new blank
record.

4th DIMENSION saves your modifications.

Choose Enter in List from the Enter menu to leave the Enter in List mode.

Global Updates

You do a global update when you want to make a specific change to a
group of records. You perform a global update to automate changes to a
database that would otherwise be tedious and time-consuming. For
example, you would perform a global update if you want to

m change all prices in an Inventory file by a certain percentage
m format a numeric or Alpha field

The global update is done by “applying” a formula to the current selection
of records. That is, the formula is used to make the change to each record
in the current selection.
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Here are some example formulas and explanations of the functions they
perform. The explanations are written as comments and follow the * sign.

Salary := Salary * 1.05 " Multiplies Salary field by 1.05
State := Uppercase (State) " Uses built-in function to uppercase State

Last Name := Uplow (Last Name) ° Uses user-written function to format Last
Name

To perform a global update, you use the Formula editor to write a formula
that is applied to each record in the current selection.

You use 4th DIMENSION’s language to create formulas. See the
4th DIMENSION Language Reference for detailed information on
programming syntax and functions.

The Formula editor provides many shortcuts for writing formulas. You can
click field names, operators, and routines to add them to the formula.

Figure 5-1 shows the Formula editor.

Editing area

Keywords area

Fields area

Keywords *
{#l Last Mame

Foutines

(v Arrays

Boolean
Communications
Compiler Directives

Firzt MNarne
Start Date

Routines area

Data Entry
Displaying

Buttons area

[ Load.. ] [ save.. | [ cancel | [ 0K

Figure 5-1
The Formula editor

The Formula editor contains the
m KEditing area that displays the formula as you build and edit it.
You create the formula in this area.

m  Keyword area that contains a list of operators used to build a formula.
See the 4th DIMENSION Language Reference for a detailed discussion
of operators.

m Fields area that displays the names of the fields and layouts in the
current file. The cycle arrows at the top of the Field area allow you
to view the contents of other files in the database. Click between the
cycle arrows to display a pop-up menu of all filenames.
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m  Routines area that contains a list of pop-up menus. Each pop-up
menu lists a group of 4th DIMENSION functions and commands. The
Routines area also displays the names of global procedures and
external procedures. These procedures appear at the end of the list of
pop-up menus.

If you click the header of the Routines area, 4th DIMENSION replaces
the list of pop-up menus with an alphabetical listing of all built-in
commands and functions. Click the area header again to return to the
list of pop-up menus. See the 4th DIMENSION Language Reference for
a detailed discussion of 4th DIMENSION commands.

=  Buttons area that contains four buttons for saving your formula,
loading other formulas from disk, canceling an editing session, and
applying the formula.

You build a formula by clicking keywords, field names, and commands.
When you click an item it automatically appears in the Editing area, where
you can modify it with standard cut, copy, and paste techniques. You can
also type directly into the Editing area.

A formula can be only one logical line long. You cannot press Return and
type another line.

To perform a global update, follow these steps:

Set the current selection to the records to be updated. For more
information on setting the current selection, see Chapter 4.

Choose Apply Formula from the Enter menu.
Use the Formula editor to build the formula.
Or Click Load to retrieve an existing formula from disk.

If you click Load, 4th DIMENSION displays an open-file dialog box and
asks you to select a file. When you load a file, it replaces any formula that
currently appears in the Apply Formula editor.

After you load a formula, you can modify it in the editing area.
If you want to save a new formula in a disk file, click Save.

4th DIMENSION displays a create-file dialog box and asks you to name a
file to store the new formula.

Click OK to apply the formula to the current selection.

4th DIMENSION closes the editor and applies the formula to the records in
the current selection.
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Click Cancel to close the editor and return to the output layout without
applying the formula.

Deleting Records

You can delete a record if you discover the record is outdated or no longer
necessary. If the record is needed but the values stored in the record are
incorrect, you should modify the record rather than deleting it.

You can delete records in two ways:
m Delete records individually from the input layout.

m Delete a subset of records from the output layout.

Warning: Deleting records is permanent and cannot be undone. When you
delete records, 4th DIMENSION displays a dialog box asking you to confirm
the deletion.

Deleting Records Using the Input Layout

Deleting records from the input layout lets you verify the contents of each
record before you delete it.

To delete records using the input layout, follow these steps:

Use a search method or navigation button to display the record you want
to delete.

Click Delete to delete the record.

Depending on the design of the input layout, the Delete button may be
represented in different ways. In the two types of templates available

in the Layout editor, the Delete button is represented by a button labeled
“Delete” and a trash can icon, respectively.

4th DIMENSION asks you to confirm the deletion. You cannot undo
the deletion after 4th DIMENSION removes the record.

Click Yes to complete the deletion. 4th DIMENSION removes the current
record from the database and returns to the output layout.

Deleting Records Using the Output Layout

Using the output layout, you can delete a subset of records in one
operation. If necessary, use one of the methods to select records that
you want to delete.
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Show Clipboard

To delete records using the output layout, follow these steps:
Highlight the record or records that you want to delete.

Or if you want to delete all the records in the file, choose Show All from
the Select menu and Select All from the Edit menu.

Highlighting records is described in Chapter 3.
Choose Clear from the Edit menu.

4th DIMENSION displays a dialog box asking you to confirm the deletion.
You cannot undo a deletion.

Click Yes to complete the deletion. 4th DIMENSION removes the selected
record or records from the file. '

Or click No to cancel the deletion.
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SORTING RECORDS

A sort reorders records according to the values in the database. It is
common to sort records

m before printing a report or labels
m to view records on screen in a particular order
m  before graphing data

When you enter data, 4th DIMENSION stores the records in the order that
they are entered or imported. When you list records in an output layout or
print records, they appear in this order. Often, you want to view records in
another order. For example, you might want to alphabetize a list of names
in a report. For example, a sort on the Last Name field reorders the records
alphabetically by Last Name.

A sort can be done while you are using an input or an output layout. If you
sort from an input layout, the first record in the new sort order is displayed
in the input layout. Otherwise, the sorted records are displayed in the
output layout.

4th DIMENSION conducts indexed sorts very quickly. If you are sorting on
only one field and that field is indexed, 4th DIMENSION uses the index.
Therefore, the sort is very fast.

Sort Levels

You can sort records on up to 30 different fields or formulas. Each field or
formula you sort on is referred to as a sort level. The first field or formula
you sort on is called the primary sort field or formula. The other fields or

formulas are called the secondary sort fields or formulas.

For example, the results of a two-level ascending sort on the last name and
first name fields would produce a list such as this:

Aardvark, Anthony

Aardvark, Artemis

Aardvark, Arthur

Zygote, Elena
Zymosian, Elmer
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Ascending and Descending Order

You can specify either an ascending or descending order for each field or
formula that you are sorting on. Sorting from A to Z or smallest to largest
is known as an ascending sort. Sorting in the reverse order is called a
descending sort—Ilargest to smallest, latest to earliest, and Z to A.

If you are sorting on more than one level, you can freely mix ascending
and descending sort orders. A multiple-level sort can mix fields and
formulas and ascending and descending sort orders.

Sorting on a Formula U6

s

You can sort on a field or on a formula. For example, the following
formula sorts on the month of a birth date field.

Month of (Birth Date)

Sort Methods

You can perform two types of sorts:

m  You can sort the records in the current selection. This is a temporary
sort; it does not affect the order in which the records are stored on
disk.

m  You can permanently sort the contents of a file. You sort the contents
of a file permanently if you frequently need to view or print records in
a particular order.

There are two sort menu items:

m Sort Selection sorts the records in the current selection. Sorting the
current selection changes the order in which records are displayed or
printed.

m  Sort File permanently sorts the records in a file. Sort the file
whenever records are usually viewed or printed in a particular order.
A permanent sort can reduce the need to sort the current selection after
a search.

ﬁ Note: The Quick Report editor can also perform sorts. For more information
on the Quick Report editor, see Chapter 8.
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The Sort Editor

The Sort editor is shown in Figure 6-1.
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The Sort editor
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e Sort editor contains the

Fields area that displays the names of the fields in the current file or
other files. Cycle arrows are used to display fields in other files. Fields
from related files can be used in the sort, provided the relation is
automatic. Indexed fields are shown in boldface.

Criteria area that displays the sort fields or formulas and the order of
the sort. The field or formula in the first row of the Criteria area is the
primary sort field or formula. The arrows on the right of this area are
used to specify an ascending or descending sort.

Edit Formula and Add Formula buttons that you use to write or edit
a formula as one of the sort levels.

Delete button that you use to delete one of the sort levels.

Cancel button that you use to cancel the sort and return to the layout
you were using.

Sort button that you use to carry out the sort.

th the Sort Selection and Sort File methods use the Sort editor.
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Using Sort Selection

Use Sort Selection to sort the current selection of records. This sort is
temporary and applies only to the current selection; it does not affect the
order in which records are stored in the database. Sort Selection is
commonly used immediately after a search.

To sort the current selection, follow these steps:

Choose Sort Selection from the Select menu.

Click the name of a field you want to sort on.

Or to sort on a formula, click Add Formula.

If you clicked Add Formula, 4th DIMENSION displays the Formula editor.

Create a formula. The formula returns the values you want to sort on. The
formula can return values of any data type.

For more information about how to use the Formula editor, see “Global
Updates” in Chapter 5.

Click OK when you are finished writing the formula. 4th DIMENSION
displays the formula in the Criteria area.

The field name or formula and a sort direction arrow appear in the Criteria
area, as shown in Figure 6-2.

direction arrow

[#][8]

Sort Employees...
b 2| |Last Name
Last Name K
First Name 1 Salary
Start Date i
Salary
Title
SSNurnber
Department Code
[
(¢ Formuin ] (Add Formula ] [Heiete | [ cancel | [ sort |

Figure 6-2
Sort editor with a two-level sort

Click the sort direction arrow in the Criteria area to switch between
ascending and descending sort order. Up is ascending; down is descending.

If necessary, repeat steps 2 and 3 to add secondary sort levels to the list.

Click Sort.
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4th DIMENSION sorts the current selection. If an input layout was being
used, the first record in the sorted current selection is displayed.

Using Sort File

Sort File permanently sorts the contents of the file. In the process, it
rebuilds all the indexes belonging to that file. While rebuilding indexes, it
displays a progress indicator.

ﬁ Note: It is wise to back up your database before sorting a file permanently. If

there is an interruption during Sort File, the database may be damaged and
need to be repaired.

To sort a file, follow these steps:
Choose Sort File from the Select menu.
4th DIMENSION displays the Sort editor.

The dialog box is exactly the same as the dialog box that appears when
you choose Sort Selection. Indexed fields appear in boldface.

Create the sort condition by following the steps just described.
Click Sort.

4th DIMENSION sorts the file, rebuilds all indexes for the file, and saves
the records in the new sort order.

If your database is very large, rebuilding indexes may be time-consuming.

ﬁ Note: After using Sort File, new records that you add to the database are not
automatically inserted in the sort order. After adding new records, you may
want to sort the file again.
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REPORTING USING LAYOUTS

One of the major functions of a database is to produce reports. In

4th DIMENSION, you can produce a report using either a layout or using
the Quick Report editor. This chapter discusses how you print a report
using a layout.

There are several advantages of using a layout for a report: you can use
graphic elements on the layout, you can control the placement of report
elements precisely, you can use scripts to perform calculations, and you
can use headers at each break.

You can use a layout to create reports that
require a non-columnar format

display included layouts

include picture fields

contain embedded graphics

contain picture areas

require special graphic elements, such as hairlines
m require complex procedural processing
Chapter 8 discusses designing and printing reports using the Quick Report

editor. The Quick Report editor is excellent for printing tabular reports that
use a standard columnar format.

This chapter assumes that you have already created a layout for the report.
For further information on designing output layouts, see Chapter 5 of the
4th DIMENSION Design Reference.

Standard Reports and Reports with Breaks

There are two kinds of reports that can be printed using output layouts,
standard reports and reports with breaks. When you create a standard
report, you simply print the current selection using a layout. Reports with
breaks separate records into groups. To create a report with breaks, you
must sort the current selection before printing.

Printing Standard Reports

4th DIMENSION prints the records in the current selection. Set the current
selection to the subset of records you want to print. If you want the report
to list the records in a particular order, sort the current selection before
printing the report.
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New Database...
Open Database...

Import Data...
Export Data...

Choose File/Layout... 3#F

Page Setup...

Layout panel

To print a standard report, follow these steps:
Select the records to be included in the report. If desired, sort the records.

Selecting records is discussed in Chapter 4 and sorting records is discussed
in Chapter 6.

Choose Print from the File menu.

The Choose Print Layout dialog box is displayed, as shown in Figure 7-1.

Choose print Tayout..

Input Layout
Cutput Layout

| cancel :|

Thumbnail panel

Cw

<

Figure 7-1
The Choose Print Layout dialog box

Choose the layout you want to use.

When you click on a layout, a thumbnail sketch of it appears in the area on
the right.

Click OK.

4th DIMENSION displays the Page Setup dialog box for your selected
printer. Choose any desired options and click OK.

4th DIMENSION displays the Print Quality dialog box for the printer you
selected in the Chooser.

To preview the report on the screen, click the “Preview on screen” check
box.

If you clicked “Preview on screen,” the report will be displayed on screen,
one page at a time. Figure 7-2 shows a report previewed on screen.
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USER -

4th DIMENSION®

Figure 7-2
Report previewed on screen

When a page of the report is being previewed, you can
m drag the frame shown within the previewed page

m view a close up of the area inside the frame by clicking Zoom

m view the next page of the report by clicking Next Page

m cancel the printing by clicking Stop Printing

m print the page being previewed by clicking Print

If you did not click “Preview on screen,” the report will be sent to the

printer you selected in the Chooser. A dialog box keeps you informed of
the progress of the operation.

Printing Reports with Break Levels

Break levels are used to separate records into groups and print summary
calculations for each group. The output layout used to print a report with
break levels must contain at least one break area. For information on
designing output layouts with break levels, see Chapter 5 of the

4th DIMENSION Design Reference.

If your report includes break levels, you must sort the current selection
before printing. When sorting records for a report with break levels, you
must sort on at least one more sort level than the number of break levels in
your output layout. If your report has one break level, use at least two sort
levels. For example, if your report lists employees by departments, the
report has one break level (Departments). You can sort on your break field
(Department Name) and one more field—Last Name. Employees will be
listed alphabetically by last name within each department.

CHAPTER 7: REPORTING USING LAYOUTS
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Header area

Break Header area ____|

Figure 7-3 shows a report with one break level.

Break area —E

Total area

[ Consumer Products Employees
Date: 6/8/89 Time: 5:43 PM
| [Accounting
| (Mame Title Salary
: Baldwin, Steve Supervisor $43,990
Detail area ——[ Johnsaon, John E]E’ff'k $18,250
Total Salaries for Accounting $62,240
Transportation
MNarne Title Salary
Bentley, Alice Engineer $28,000
Garbando, Smeldorf  Clerk $19,610
Total Salaries for Transportation 347,610
Total Salaries for Company $109,850
= Salaries by Department Fage: 1

Footer area

Figure 7-3

A report with one break field (Department)

When you print a report with break levels, you must turn on break
processing. Break processing causes 4th DIMENSION to break the records
into groups and compute summary calculations.

There are two ways to turn on break processing. If the layout uses the
Subtotal function, break processing is turned on automatically. Break
processing can also be turned on by executing a short global procedure
when the report is printed. The global procedure must contain two
commands, ACCUMULATE and BREAK LEVEL. For more information on
using these commands in a procedure, refer to those commands in the
4th DIMENSION Language Reference. For information on how to use the
Subtotal function in output layouts, see Chapter 5 of the 4th DIMENSION
Design Reference.

You can execute the procedure using the Execute Procedure menu item.
See Chapter 11 for more information about executing global procedures.

To print a report with breaks, follow these steps:
Select the records to be included in the report.

Selecting records is discussed in Chapter 4.
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Sort the records by at least one more level than the number of breaks in the
report.

Sorting records is discussed in Chapter 6.

Execute the procedure that turns on break processing.

ﬁ Note: This step can be skipped if the output layout turns on break processing
automatically.

Choose Print from the Fiie menu -
The Choose Print Layout dialog box is displayed.
Choose the layout you want to use. '
Click OK.

4th DIMENSION displays the Page Setup dialog box for your selected
printer. Choose any desired options and click OK.

4th DIMENSION displays the Print Quality dialog box for your selected
printer.

To preview the report on the screen, click the “Preview on screen”
check box.

If you clicked “Preview on screen,” the report will be displayed on screen,
one page at a time. See the description of the options available for
previewing a report in “Printing Standard Reports,” earlier in this chapter.

If you did not click Preview on screen, the report will be sent to the printer
you selected in the Chooser. A dialog box keeps you informed of the
progress of the operation.
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QUICK REPORTS Mobe. D 192

One of the most important tasks in data management is the generation of
reports. You can use the Quick Report editor to create a wide variety of
columnar reports. Using the Quick Report editor you can

m produce lists of records
m create break areas
m compute summary calculations

m use fonts and styles in the report

The Quick Report editor is one of two tools used to design reports. You
can also design reports using the Layout editor in the Design environment.
You should use an output layout to design reports that require complex
layouts, procedural processing, or graphics. For information about when to
use the Layout editor, see Chapter 7.

The Quick Report editor produces reports from the current selection of
records. Before you print a report, set the current selection to the records
you want to include in your report using one of the methods for selecting
records described in Chapter 4.

4th Dimension’s Quick Report editor lets you create and print tabular
reports. Figure 8-1 illustrates a typical Quick Report.

Marne Last Name Salary
Accounting Ealdwin $4Z 930
Jehnson $18,250
Subtotal for Accounting $£2,240
Administration  iHanson $40 520
Pfaff $26 440
Smith $26 500
Terry $16,190
Wilson $36,500
Subtotal for Administration $145,150
Art Forbes $18,240
Martin $56,144
Tornpkins $19,770
Venable $43,520
Voltz $25,150
Subtotal for Art $163,424
Grand Total: $371,814

Figure 8-1

A quick report
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When you create a quick report, you can specify

m columns that display fields or formulas, either from the current file
or from related files

a sort order

break levels
summary calculations
text for labels

formats for numeric data

font, font size, style, and justification for labels, summary calculations,
and data

®  page headers and footers

A quick report can be printed

m on the standard printer selected in the Chooser
® on a serial printer

® todisk

®m toagraph

These options are discussed in the section “Selecting an Output Device”
in this chapter.

Quick Report Basics

This section describes basic operations used in using the Quick Report
editor to design a report.

Creating a New Quick Report

To create a Quick Report design, choose Quick from the Report menu.

4th DIMENSION displays the Quick Report editor. If an existing design
is displayed, choose New to begin a new Quick Report design.



New %N
Open... 0

Save as...

Print to...
Page Setup...
Print... &P

Close EW

Save... #S
Save as...

Print to...
Page Setup...
Print

T

Loading and Saving a Quick Report Design

You can save a Quick Report design as a file that you can open from the
Quick Report editor. The Quick Report design includes all your
specifications, but not the data. By saving report designs, you can maintain
a library of quick reports that you can use depending on your needs.

ﬁ Note: If you do not save your design, it is displayed the next time you open
the Quick Report editor in that work session.

To save a Quick Report design, follow these steps:
Choose Save from the File menu.
4th DIMENSION displays a create-file dialog box.

Enter a filename for the Quick Report and click Save. 4th DIMENSION
saves the report as a file that you can open with the Quick Report editor.

If you are saving a report previously saved or loaded, it replaces the old
report.

When the Quick Report editor is open, you can load a saved design and
use it to print a new report. The same Quick Report design can be used
repeatedly to print different selections of records.

To load a report design, follow these steps:
Choose Open from the File menu.

4th DIMENSION displays an open-file dialog box displaying a list of
available Quick Report designs.

Select a file from the list and click Open.

4th DIMENSION replaces the current report design with the design
you opened.
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The Quick Report Editor

Column header

This section describes the main features of the Quick Report editor.

Figure 8-2 shows the Quick Report editor.

Field Selection box Reports... X R%port with frame
- " - Name iLast Name Salary K3
ggtaacllle J lt“‘s*t'\l‘:me ﬁ | H |Name iLast Name Salary
ws lame
B k Start Date grnE
rea Salary B1 Subtotal for *# Sum
Total rows e T Grand Total: Sum
Cell Department Cade —
Review Info
Sort box {
Sort
Column indicator Name
Last Name
Row label bar o ok
Summary calculations
check boxes [ Sus [ seerage [ a4
[ Mas [ Count

W
Cancel 0K O 8uts salumn widih

Figure 8-2
The Quick Report editor

The Quick Report editor contains the

Field Selection box that lists fields in the current file. You can view
the names of fields in other files by clicking the cycle arrows at the top
of this box.

Sort box that displays the sort order assigned to the report. It also
contains the <<Add Sort>> marker that you use to set sort levels. If
your report will contain summary calculations from groups of records,
you must sort the current selection by one or more columns.

Quick Report layout that is used to design the report by dragging
fields, adjusting column widths, and adding or deleting breaks.

Report with frame check box that lets you add a rectangular frame to
your report.

Summary calculations check boxes that are used to place summary
calculations in the Break and Total areas of the report.

Column indicators that indicate the boundaries between columns of
the report.

Auto column width check box that is used to request the Quick
Report editor to compute a column width based on the maximum
length of the contents of the column. This option can be checked for
each column individually. This check box does not refer to the entire
report.
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If “Auto column width” is checked, the Quick Report editor computes
column widths at the time the report is printed. If Auto column width
is not checked, you can modify column widths by dragging column
indicators.

m  Right margin marker that indicates the right margin of the report.
The right margin marker is meaningful only when no columns have
“Auto column width” checked. On a 9 inch monitor, you must scroll
the Quick Report layout to the right to view the Right margin marker.

m  Column header displays the names of fields or formulas added to
the report.

m  Row label bar shows the different areas of the report: the Header,
Detail, Break, and Total rows.

m Header row contains information that appears in the printed report
above the records. The Quick Report editor automatically places field
names in the Header row, but you can modify its contents.

m  Detail row prints information from individual records and will be
repeated in the printed report for each break.

m  Break and Totals rows that display summary calculations and any
associated labeling. The Break row displays summary calculations for
each subgroup in the report and the Totals row displays summary
calculations obtained from all records in the current selection.

m Cells that are the intersection of a row and a column.

m  Scroll bars that let you view parts of the Quick Report design that
extend beyond the area of the Quick Report layout.

Figure 8-3 on the next page shows a completed Quick Report design and
the relationship between the specifications in the design and the printed
output.
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Department Name c2

Title Salary

all Departments

H P Name | Name Title Salary
D s 4en 440
81 Statistics for i Average [ Average
Department: # Count N count

I Statistics for Average (n) Average
Count

Count

.

=] Department Name Name Title Salary
Accounts Payable Smith, Mary Accountant $26,650
L Lindsay, Georgina Manager $28,324
Klutz, Karla Accountant $23,500
Fredrickson, Anna Secretary $18,750
Chavez, Richard Accountant $31,200
L Statistics for Average $27,987
Department: Accounts Payable Count 5
Accounts Receivable Smith, Sally Accountant $35,567
Newton, Kendall Manager $38,550
Kane, Cindy Accountant $27,000
Irving, Samuel C Secretary $17,500
Statistics for Average $29,261
Department: Accounts Receivable Count 4

A P - AT T P e N

N et S ,,/ \‘n._..,_/f \\.,_ i \\ e
N, o s e P A —“"\\ ATy .
S - s N N L
m— Statistics for Average $30,616
all Departments Count 77
Figure 8-3

A Quick Report exampl

e

Selecting Rows, Columns, and Cells

When designing a quick report, you need to select rows, columns, and
cells in the Quick Report layout. A cell is the intersection of a row and

a column.

To select a row, follo

m  Click on the H, D, B, or T marker on the left of the Quick Report

Layout.

Or click in a row to the right of all columns in the Quick Report

layout.

w this step:

To select a column, follow this step:

m Click above the Header row of a column

To select a cell, follo
m Click the cell.

w this step:
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Adding and Modifying Text

You can add or modify text in the Quick Report layout. Text can be used
to label parts of the report. For example, if you requested summary
calculations, you can also add text to other cells in the Break and Total
rows to label the summary calculations.

You can

m edit the text that 4th DIMENSION automatically adds to the Header
row of the report

m insert text in empty cells of the Break and Totals rows
m insert the value of a Break field in the Break rows

m specify font, font size, justification, and style for any text that appears
in the report

To add text, follow these steps:
Click twice on an empty cell in the Quick Report layout.
A text insertion point appears in the cell.

If you are entering a label for a summary calculation, select a cell in the
same row as the cell containing the calculation icons. You cannot enter
text into the same cell that contains summary calculations.

Type the text in the cell.

To edit text, follow these steps:

Drag across the text in the cell you want to modify.
4th DIMENSION highlights the selected text.

Type the new text in the cell.

Specifying Font, Font Size, Justification, and
Style

While designing your quick report, you can specify different fonts, font
sizes, justification, and styles. You can apply these specifications to rows,
columns, or cells in the quick report. These specifications can be applied
to text, data, and summary calculations.

If you assign specifications to the Detail row of the report, you won’t see
the results until you preview or print the report.

To specify a font, follow this step:

m  Select the column, row, or cell where you want to apply the font.
Choose a font from the Font menu.
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4th DIMENSION applies the font to any text, data, or summary calculations
that appear in the selected area.

To specify a font size, style, or justification, follow this step:

m Select the column, row, or cell and choose a font size, style, or
justification from the Style menu.

4th DIMENSION applies the font size, style, or justification to any text,
data, or summary calculations that appear in the selected area.

Adding Columns to the Report

You create columns by dragging field names from the Field Selection box
to the Quick Report layout. Use the cycle arrows in the Field Selection box
to display field names from related files in the database. You can add fields
from related files to the report, provided the relationship is automatic.

To add a column, follow this step:

m Drag the name of a field to the right of existing columns in the
Quick Report layout and release the mouse button.

4th DIMENSION creates a column for the field and places the field name in
both the column header and the cell in the Header row. Figure 8-4 shows a
column being added to a quick report.

Reports... Report with frame

| - ad First Name l-f_d
Ernployee Mumber First Marme .
Last Name .
First Namne

Department Code

Salary

Ficture

Review Info

Office Lacation

¥

Himioix

Sort
<oAdd Sorter

[J Sum [JAverage [ Min
[ M™Max [J Count
( cancel | [ 0K ] [ Auto columr width

Figure 8-4
Dragging a field to the Quick Report layout

By default, 4th DIMENSION prints the field names as column heads at the
top of each page in the quick report.

ﬁ Note: If you use a subfield in a Quick Report design, the report will list all
values of the subfield for each parent record. You cannot sort on a subfield.
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Inserting Columns

You can insert a column in a quick report.

To insert a column, follow these steps:
1. Select a column.

2. Choose Insert Column from the Edit menu.

4th DIMENSION inserts a blank column to the left of the column you
selected. You can then assign a field to the empty column by dragging a
field name to it or assign a formula to the column. For information on
assigning a formula to a column, see the section “Adding Formulas to the
Report” later in this chapter. -

sists break Deleting Columns

As you specify fields for your quick report, you may want to remove some
columns so that they can be placed elsewhere. You also might want to
delete the column from the report.

To delete a column, follow these steps:
1. Select the column you want to delete.
2. Choose Delete Column from the Edit menu.

4th DIMENSION removes the selected column from the Quick Report
layout.

Replacing Columns

You can also replace a column in the quick report by dragging another
field over it. You can also replace a field with a formula.

To replace a column, follow this step:

m Drag a field from the Field Selection box to the column you want to
replace.

Or select the column you want to replace and choose Edit a Formula
from the Other menu.

See the section “Adding Formulas to the Report” for information on
adding a formula to a quick report.

When you print the Quick Report, 4th DIMENSION will print the results of
the formula for each record that appears in the Detail row.
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Other
Edit a Formula...

Sizing Columns

By default, the Quick Report editor sizes columns automatically. It sizes
each column based on the maximum length of data displayed in the
column and any labels typed into the column. The Quick Report editor
sizes columns at the time the report is printed.

To view the widths of each column, preview the report to the screen.
Because the “Auto column width” option will change the width of a
column based on the maximum width of data in the records being printed,
selecting different records can change the size of columns.

See the section “Printing the Quick Report™ in this chapter for more
information about previewing the report.

You can resize a column manually after turning off the “Auto column
width” option. When a column is set manually, text in the column wraps
within the area specified.

To resize a column manually, follow these steps:
Select the column you want to resize.
Deselect the “Auto column width™ option.

Move the pointer over the column indicator in the column header to
change the pointer into a column width cursor. Figure 8-5 shows the
column width cursor.

i+

Figure 8-5

The column width cursor

Drag the column indicator to the left or right to size the column.

Adding Formulas to a Quick Report

You can add a formula to a column in a quick report. For example, you can
add a formula that computes employees’ monthly salaries from an Annual
Salary field.

To add a formula, follow these steps:
Insert an empty column and choose Edit a Formula from the Other menu.

Or click a column and choose Edit a Formula. The formula will replace
previous contents of the column.

4th DIMENSION displays the Formula editor where you can build a
formula.
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Build the formula by clicking fields, keywords, and commands and
entering values. For more information on using the Formula editor, see
the section “Global Updates™ in Chapter 5. ?“\'j 2 70

To save the formula as a file that you can recall and use in another column
or in another report, click Save and enter a filename in a create-file dialog
box.

Click OK to assign the formula to the column.

4th DIMENSION adds a new label to the column that identifies it as a
formula. You can relabel the column by typing a label into the header cell
for that column. '

Formulas are labeled C1 through Cn. The labels are the names of variables
that contain the column’s value. You can use these variables in other
formulas.

Sorting Records and Creating Breaks

An important feature of the Quick Report editor is the ability to sort the
records in your report. You sort records for two reasons:

® to view records in a particular order

m to create groups of records and Break areas in the report for the
purpose of reporting summary calculations for groups. See the section,
“Setting Break Levels,” for information on summary calculations.

Specifying a Sort Order

After you specify the columns for your report, you can specify a sort order.
You set a sort order by dragging the <<Add Sort>> marker in the Sort box
to columns that you want to sort on. For example, if you want to sort
salesperson records by the Sales Region field, you drag the <<Add Sort>>
marker to the Sales Region column.

You can also sort on a formula. Simply drag the <<Add Sort>> marker to
the column that contains the formula. See “*Adding Formulas to the
Report™ earlier in this chapter for more information on adding formulas to
quick reports.

To specity the sort order, follow these steps:

Drag the <<Add Sort>> marker from the Sort box to the column on the
Quick Report layout that contains the field or formula you want to specify
as the primary sort level. See Figure 8-6.
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Figure 8-6

Dragging the <<Add Sort>> marker

When you release the mouse button, 4th DIMENSION displays the name of
the field in the Sort box.

If desired, drag the <<Add Sort>> marker to additional fields or formulas
to specify secondary sort levels.

When you specify multiple sort levels, 4th DIMENSION will sort the
records on the first field in the Sort field list, then on other fields in the
order that they appear in the list. For example, if you specified the
Department Name as the primary Sort field and Last Name as the
secondary Sort field, your Quick Report design might look like Figure 8-7.

Reports... [ Report with frame

First Name ilast Name iDepartment Name (Salary IGI
First Name ilLast Name iDepartment Name (Salary

-
Employee Number
Last Narne

First Namne
Department Code
Salary

Picture

Review Info
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Last Name

Secondary sort field _]
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Figure 8-7
A quick report with two sort levels
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m Drag the name of a Sort field or formula in the Sort box to a new
column.

To change a Sort field, follow this step:

The new column becomes a sort field. Its name appears in the Sort box.

Deleting a Field or Formula from the Sort Order

You can delete the last field or formula from the Sort list. To specify a new
sort order, you can delete all the fields from the Sort list and build a new
list.

To delete the last sort field, follow this step:

m  Choose Delete Last Sort from the Other menu.

Edit a Formula... i i
v o Tormua 4th DIMENSION removes the last field or formula in the Sort field list. It
does not delete the column itself from the report. When you print the
Cane broni report, 4th DIMENSION will no longer use that field or formula to sort
- records.

Setting Break Levels

In a quick report, you set break levels to separate or “break” records into
groups according to values in one or more sort fields. At each break level a
Break area is printed. You can print summary calculations in the Break
area. The summary calculations—sum, average, minimum, maximum, and
count—are computed for each group of records.

Break levels are determined by the sort levels and Break rows. For
example, if you tell 4th DIMENSION to sort records by Sales Region and
create a Break row, 4th DIMENSION inserts a break between each group of
records that have the same sales region.

After you add a Break row to the quick report, you can request summary
calculations on each break. For example, you can insert a summary
calculation in a Break row to display subtotals for sales from each state in
a marketing region.

See “Adding Summary Calculations” later in this chapter for more
information on adding summary calculations to Break and Total rows.

To insert a Break row, follow these steps:

1. Select the Totals (T) row.

Insert Break

2. Choose Insert Break from the Edit menu.

4th DIMENSION adds a Break row. Figure 8-8 shows a Break row in a
Hide Line Ll Quick Report layout.
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Break row
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<<Add Sort>>

[ cancel | [ oK

Figure 8-8
A quick report with a Break row

If desired, add additional Break rows by selecting an existing Break row
and choosing Insert Break from the Edit menu. There should be at least as
as many sort levels as break levels.

4th DIMENSION adds a sequential number to each new break label in the
row label bar, for example, B1, B2, B3, and so forth.

Using the Values of Break Fields in Labels

You can improve the appearance and comprehensibility of your reports by
labeling each Break row using the value of the Break field.

To request that the value of a Break field be printed in a label placed in the
Break area, use the number sign (#) in the label. For example, the text
“Total salaries for department #” will insert the department name (in this
case, the value of the Department field) in place of the number sign when
the report is printed.

The number sign does not need to be placed in the break field; it will
display the value of the Break field in any cell in the Break row.

Figure 8-9 illustrates the use of the number sign in a label in the
Break row.
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Figure 8-9
Using the number sign in a Break row label

Adding Summary Calculations

Summary calculations on the contents of fields and formulas can be added
to each Break row and to the Totals row.

The check boxes at the bottom of the Quick Report editor identify the
summary calculation options available for Quick Reports. The available
types of summary calculations are the

m  Sum, which is the total of the values in the report or break

s  Minimum, which is the lowest value in the report or break

m  Maximum, which is the highest value in the report or break

m  Average, which is the mean of the values in the report or break

m  Count, which is the number of records in the report or break

When a summary calculation is placed in the Totals row, the calculation is

done for all the records in the report. If the summary calculation is placed
in a Break row, the calculation is done for the records in each break.
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Sum summary
calculation icon

To add a summary calculation, follow these steps:

Select a cell—the intersection between row and column—in a Break row
or the Totals row where you want to insert the summary calculation.

The Sum, Minimum, Maximum, and Average calculations work only on a
numeric field or formula.

Click as many summary calculation check boxes as you like.

4th DIMENSION displays a calculation icon in the selected cell for each
type of summary calculation you request.

Figure 8-10 shows a summary calculation icon added to the Totals row.

Reports... [ Report with frame
- First Mame iLast Mame (Departrient Name (Salary }{}
Ermnplayes Nurmber H  |First Mame ilLast Mame Department Marme iSalary
Last Mame o
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Picture = D
Review Infa
Office Location

Sort

Department Name K
Last Name M
<<Add Sort>>
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2 [JSum [J Average O Min
~| [JMan [ Count
[ cancel | [ 0K | [JAuto column width

Figure 8-10
A calculation icon in the Totals row

If you add more than one summary calculation to a cell, 4th DIMENSION
stacks the calculation icons on top of each other. This is shown in
Figure 8-11.
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Figure 8-11

Multiple calculation icons in a cell

If you added summary calculations to a Break row, 4th DIMENSION
will perform the calculation on each group of records specified by the
Break fields. If you added the summary calculations to the Totals row,
4th DIMENSION performs the calculation on all the records in the report.

)

\ . "

) Setting Numeric Formats

/ You can specify formats for columns that contain numeric data. For

f example, if you are displaying salaries in a column, you can add a format
to the Detail cell for the Salary field. The following format places a dollar
sign to the left of the number, allows up to 9 places to the left of the
decimal and two places to its right:
S #it# ##0.00
This format can display dollar amounts up to $999,999,999.99.
You can create formats by using the formatting symbols and rules
described in Chapter 4 of the 4th DIMENSION Design Reference.
You can also use a style as a format.
To set a numeric format, follow these steps:

1. Click twice in the Detail cell for a numeric field.

2. Type a format or the name of a style.

The names of styles are preceded by a vertical bar (I).
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Numeric format

If you have also requested summary calculations for that column, the
format specified in the Detail cell will automatically be applied to the
summary calculations. The Count is always displayed as an integer and
ignores formatting symbols, such as the dollar sign.

Figure 8-12 shows a numeric format added to a detail cell in a Quick
Report layout.
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Figure 8-12
Numeric format in a quick report cell

Different formats can be applied to different columns in the report.

Hiding Rows

4th DIMENSION lets you hide rows when printing a Quick Report. This
feature is useful, for example, when you want the report to include only
summary calculations. Hide the Detail row if you want to display only the
summary calculations that appear in the Totals and Break rows.

You can also use this feature to hide a Break row or the Totals row.
To hide a row, follow these steps:

Select the row you want to hide.

Choose Hide Line from the Edit menu.

4th DIMENSION places an icon in the selected row label bar that reminds
you that the row won’t appear when you print or preview the quick report.
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Adding Page Headers and Footers

Before printing a quick report, you can add page headers and footers. You
specify page headers and footers in the Format dialog box. Use this dialog
box to

m add page header and footer text
m specify the size of the page header and footer areas
m specify fonts, font sizes, and font styles for page header and footer text

m insert codes that add page numbers, date, and time to your reports

Page headers can only be specified when printing to a normal or Direct
ASCII printer. See the section, “Selecting an Output Device” later in this
chapter for more information about alternate output devices.

To add page headers and footers, follow these steps:
Choose Page Setup from the File menu.

If you have chosen Normal printer in the “Print to” dialog box, the
standard Page Setup dialog box is displayed. If you have chosen Direct
ASCII, the serial printer driver dialog box is displayed. See Figure 8-17.

Select any printing options you want and click OK.

The Quick Report Format dialog box, shown in Figure 8-13, is displayed.

Left header: Center header: Right header:

Header size:

@ Pixels [ cancel |
) Inches —
O cm 0K
Footer size:
Left footer: Center footer: Right footer:
Figure 8-13

Quick Report Format dialog box
Enter header and footer height in the provided entry areas.

As you enter header and footer height, the dotted lines on the page preview
area will change to indicate the size of the header and footer as they will
appear on the printed report.
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4. Select one of the six Header and Footer entry areas and type the header or
footer text. Figure 8-14 shows header and footer text entered in the format
dialog box.

Left header: Center header: Right header:

Report title

Header size:

@ Pixels Cancel
) Inches
Footer size:
Left footer: Center footer: Right footer:
Report footer texnt
Figure 8-14

Example header and footer text

Specifying Fonts, Font Sizes, Justification, and
Styles

You can also specify different fonts, font sizes, justification, and styles for
page headers and footers.

To apply these specifications, follow these steps:
1. Select the page header or footer area in the Page Preview area.

Figure 8-15 illustrates a selected page header.

Left header: Center header: Right header:
Report title
Header size:
@ Pixels Cancel
) Inches
Footer size:
Left footer: Center footer: Right footer:
Figure 8-15

Selecting the page header
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Apply the fonts, font sizes, justification, and styles by choosing the desired
items from the Font and Style menus.

Adding Page Numbers, Time, and Date

Add page numbers, time or date to the quick report by entering the codes
shown below in the Page Header or Footer areas.

The following codes are available:

m #P adds a sequential page number
m  #H adds the time of printing

m  #D adds the date of printing

You can also embed these codes within header or footer text. For example,
you can enter the label “Page #P” in a Header or Footer area.

Accepting the Page Setup

When you are satisfied with your quick report page setup, click OK to
accept the setup and return to the Quick Report editor.

The headers and footers specified will remain in effect until you choose
Page Setup again and modify the settings.

Selecting an Output Device

New 3N
Open... #*#0
Save... S
Save as...

Page Setup...
Print... #P
Close W

4th DIMENSION supports four types of output devices for quick reports.

To select a print option, choose “Print to” from the File menu.
4th DIMENSION displays the “Print to” dialog box.

— Printto: ———— _ Thg 0’>(ii/’~' uf
@ . Normal printer ’Plzlﬂ tmzj e Jc,lzz,v
#obE v (,(Lb/e,

) Direct ASCII
O Disk file .Qz(fm}';C ?(i/g. 2) ?

] Graph Y ;/0(;(/7 —?-e‘f €RRaC \
4—‘5‘ «._Sclzuv D,SP/] 2. /4;

|: Cancel | ||' 0K )I

Figure 8-16
“Print to” dialog box
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The following options are available in the “Print to” dialog box:
Normal printer uses the printer you choose with the Chooser.

Direct ASCII sends your Quick Report to a driver that prints the report on
a high-speed serial printer or to another device. If you click Direct ASCII,
you also need to click the name of a driver in the list of available drivers.
A serial driver for the Apple ImageWriter is included with

4th DIMENSION. For more information on driver software for other
printers, contact ACIUS or ACI.

If you selected Direct ASCII and the ImageWriter driver, 4th DIMENSION
displays the ImageWriter serial driver dialog box when you choose page
setup.

Printer setup...

Char Width ~ Line Height Serial Port
29 chars/inch @ 6 lines/inch @ Modem
10 chars/inch (8 lines/inch O Printer

(12 chars/inch
(3 13.4 chars/inch
@® 15 chars/inch
(17 chars/inch

( Page Size

(0 8.5by 11 inches
{® 8.5 by 12 inches
| cancel ] (021 by 29.7 cm

Ootner[Juy[ ] &

Figure 8-17
ImageWriter serial driver dialog box

Select the options that are appropriate for your report design and paper and
click OK.

Disk file sends your quick report to a disk file that you can open and
modify with other applications, including text editors and spreadsheets.
This is, in essence, an export of the records in the quick report.

Graph directs the report to the Graph editor. The Graph editor uses the
data in the Break row. You can use this option to graph the contents of the
report using any of eight graph types. Your graph can be printed through
the Graph editor.

When you choose the Graph option in the “Print to” dialog box, your
report is graphed rather than presented in tabular form. The Graph editor
uses only the summary calculations and labels in the Break row. It uses the
leftmost non-numeric column for the x-axis.



Value that will
be graphed

USER

To use this feature, your report should

m Include from one to five numeric fields or formulas. These columns
will be assigned to the y-axis in the graph.

m  Use one type of summary calculation per numeric field.

For example, if you want to graph average salary by department, create a
quick report with two columns, Department Name and Salary. Use the
Average summary calculation for Salary.

Figure 8-18 shows how such a Quick Report design would look.

Reports... Report with frame
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Figure 8-18
A quick report for graphing average salary by department

Figure 8-19 shows the graph produced by the Graph editor.
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Figure 8-19
A column graph of average salary by department
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Printing a Quick Report

After you have completed your report design, you can print the quick
report. If you are printing to a normal printer, you can preview the report
before printing it.

To print to a normal printer, follow these steps:
Choose Print from the File menu.

Click OK and follow the standard 4th DIMENSION procedure for
previewing and printing your report. For more information about printing,
see the section “Printing Standard Reports™ in Chapter 7.

To print to a direct ASCII printer, follow these steps:
Choose Print from the File menu.

4th DIMENSION displays the serial driver dialog box for thr printer you
chose in the “Print to” dialog box. If you chose the ImageWriter, the dialog
box shown in Figure 8-17 is displayed. If you are using a different serial
printer, this dialog box may be different.

Choose the settings that are appropriate for your report and click OK.
To print to a disk file, follow these steps:
Choose Print from the File menu.

4th DIMENSION displays the standard create-file dialog box and asks you
to enter a filename.

Enter a filename and click OK.

4th DIMENSION displays a dialog box that keeps you informed of the
progress of the operation. Click Stop Printing to cancel the operation.

After the report is printed to a file, 4th DIMENSION returns you to the
Quick Report editor. Remember to change the output device if you want to
resume sending a quick report to a standard printer.

To print to a graph, follow this step:

® Choose Print from the File menu.
4th DIMENSION graphs your data as a column graph.

You can use the Graph editor to select another graph type, and to print or
preview the graphed data. For more information about the options
available in the Graph editor, see the section “Viewing the Graph” in

Chapter 10. ?ad"— 133



LABELS







Report

Labels...

38J

e

LABELS

4th DIMENSION's Label editor provides a convenient way to print a wide
variety of labels. The Label editor lets you create

m  mailing labels

m labels for file folders

m labels for file cards

and labels for many other needs.

The Label editor is visually oriented and very easy to use. Using the Label
editor, you can

m design the label

m specify the number of labels across and down on each page
m load and save label designs

m specify the output device

m print labels

Labels can also be created using the Layout editor in the Design
environment. For more specialized labels, use the Layout editor to create
labels. If you use the Layout editor you can

m specify the font, font size, and style of the label
m include separators between fields

m use variables in the labels

For more information on using the Layout editor to create labels, see
Chapter 5 of the 4th DIMENSION Design Reference.

The Label Editor

The Label editor contains facilities for designing the label, determining the
size of each label, and the left, right, top, and bottom margins. You can
save a label design to disk.

To open the Label editor, follow these steps:
Choose Labels from the Report menu.

4th DIMENSION opens the Page Setup dialog box for your selected printer.
The Label editor needs to know which printer you will use so that it can
format the page accurately.

Click the settings that apply to the labels you will be using and click OK.
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Fields box

4th DIMENSION displays the Label editor.
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Figure 9-1

The Label editor

The Label editor contains the

Fields box that lists the names of fields in the current file. If this file is
related to other files, the relating fields are shown in boldface. You can
display fields from the related file by double-clicking the fields shown
in boldface. The fields in the related file are indented.

Label layout that is used to preview your label.
Line buttons to add, delete, and combine lines on the Label layout.

Labels across and down boxes are used to control the size of labels
by specifying the number of labels that appear on your label paper.

Label page preview that provides a reduced view of how an entire
page of labels will look, based on the dimensions you enter in the
Label editor. The page preview will also represent the paper size
selected in the Page Setup dialog box.

Margin boxes are used to specify the size of the label paper margins.
Margin settings also affect the dimensions of the label. You can
specify margins in pixels, centimeters, or inches.

File buttons provide options for printing, saving, and loading label
design.

Use layout check box that lets you bypass the Label editor and use the
output layout to print your labels.

If you use the output layout, 4th DIMENSION executes any layout
procedures and scripts associated with the layout. Typically, a script
attached to an active object is used to create the label.



See Chapter 5 of the 4th DIMENSION Design Reference for more
information on designing layouts for labels.

Saving and Loading Label Designs

4th DIMENSION lets you save each label design as a file that you can open
from the Labels editor. By saving label designs, you can maintain a library
of labels that you can use according to your needs.

To save a label design, follow these steps:
Click Save.

4th DIMENSION displays a create-file dialog box where you can enter a
filename for the label design.

Type a filename and click Save.

After you save the label design, you can load it whenever the Label editor
is active.

To load a label design, follow this step:

m  Click Load.

4th DIMENSION displays an open-file dialog box where you can select the
name of a label design file. Choose a filename and click Open.

4th DIMENSION replaces the current label design with the design you
selected.

Creating a Label Design

This section describes the process of creating a label.
To create a label, follow these steps:

Click the name of the first field you want to display in the label. To select a
field from a related file, double-click on any fields that are displayed in
boldface to expand the list. Then click on the field from the related file.

Click the New Line button.

4th DIMENSION creates a line in the Label layout containing the field
name, centering the line in the middle of the label. Figure 9-2 shows one
line added to a label.
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A line added to a label

Add fields to the line by clicking field names and clicking Add to Line.

A “+” between field names in the Label layout indicates that the fields are
joined on a single line. When 4th DIMENSION prints the label, it will insert
a space between the fields on the same line.

When you are ready to place a field on a new line, click on a field name
and click the New Line button.

4th DIMENSION places the field directly below the first line.

As you add fields and lines to the label design, 4th DIMENSION
automatically adjusts the position of the lines on the label so that the entire
label text is centered. Figure 9-3 shows a sample mailing label.
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Figure 9-3

A sample label
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4th DIMENSION handles missing data intelligently when printing labels:

m If afield in a line contains no data for a particular record,
4th DIMENSION concatenates the remaining fields in the line
without leaving a blank space for the missing data.

m If an entire line contains no data for a particular record,
4th DIMENSION vertically concatenates the remaining lines in
the label without leaving a blank line.

To clear the last field, follow this step:
m Click Clear Last.

The last field in the label layout is removed.
To redo a label, use Clear Last to remove all existing fields and start again.
To specify label size, follow these steps:

Enter numbers of labels in the Labels across and down boxes to specity
the layout of the label paper.

The Label Preview area adjusts to display the appearance of the labels on a
printed page.

[ New Line
(Add to Line] First Mame+ Lsst Mame
Clear Last ] | #ddress
ity + State+ Zip
N Use
[
. o Layout
Labels across: @down: | Load... ]
[ save.. |
Top margin: 0 . 4
Bottom margin: |0 | Print to... |
Right margin: D

. | cancel |
@ Pixels (O Cm ) Inches

Figure 9-4
Specifications in the Labels across and down boxes

Click the unit of measurement to use for entering margin sizes.
Enter values to reflect the actual margins on your label paper.

The size of the individual labels in the Label page preview will adjust to
accommodate the margins. For example, if you increased the size of your
margins to two inches, top and bottom, the size of the individual labels
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would shrink to maintain the same number of labels that you specified
earlier.

ﬁ Note: Depending on the characteristics of your printer, you may need to print
test labels and adjust the position of the paper in the printer and your margin
settings until you get satisfactory results. You can then save the setup.

First Mame {F =
Last Name = [ New Line ]
Address e F
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Top margin: 22
Bottom margin: |19 (Print to... |
Left margin: Print... |
Right margin: 15 —
ght marg Gomedl |
@ Pigels (O Cm O Inches

Figure 9-5
Adjusted margins

Selecting an Output Device

4th DIMENSION supports two output devices for labels. Select an output
device by clicking the “Print to” button.

The options available in the “Print to” dialog box are
= Normal printer, which uses the printer you chose with the Chooser.

m  Direct ASCIIL, which sends your labels to a driver that prints the labels
on a high-speed serial printer or to another device. If you click Direct
ASCII, you also need to click the name of a driver in the list of
available drivers. A serial driver for the Apple ImageWriter is included
with 4th DIMENSION. For more information on driver software for
other printers, contact ACIUS.

To select an output device, follow these steps:
Click the “Print to™ button.
4th DIMENSION displays the “Print to™ dialog box.
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Figure 9-6
“Print to” dialog box

Click the output device you want to use.
Click OK to close the dialog box.

If you selected Direct ASCII, select a serial driver. 4th DIMENSION
displays the serial printer setup dialog box for the printer you selected.

Select the options that are appropriate for your printer and label design
and click OK.

Printing Labels

After you have completed your label design, you can preview the labels or
print them. You may want to first print on regular paper so that you can
check the placement of text before you use the more expensive label paper.

Before you print, select a printing option using the “Print to” dialog box.
If you are printing to the device selected in the Chooser, click Print and
follow the standard procedure for printing and previewing your labels.

If you selected the Use Layout option, 4th DIMENSION will use the current
output layout to print the labels. It assumes that the layout was designed to
print labels.

If you print labels designed in the Label editor, 4th DIMENSION uses the
Geneva font on the ImageWriter and the Helvetica font on PostScript
printers.

After the labels are printed, 4th DIMENSION closes the Label editor and
returns you to the layout you were using when you chose Labels from the
Report menu.
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GRAPHS

The Graph editor is used to design and print a wide variety of standard
business graphs. Using the Graph editor, you can plot your data without
having to export the data to a graphics package.

You can print your graphs or copy them to the Clipboard and paste them
into another application.

j : The Graph editor produces
m Column graphs which represent values as columns.

Al m Proportional column graphs which represent values as columns,
and stacks the columns to represent percentages of a total.

il m Stacked column graphs which represent values as stacked columns.

m Line graphs which represent values as points and connects the points
with a line.

® Area graphs which shade the area below a line.

= Scatter graphs which display values as points on an x—y grid.

Zeils m Pie charts which display data in a circular chart where each value
is represented by a slice of a pie.

m  Picture graphs which represent each value with a picture. You can
specify the picture to be used.

You can modify the graph’s scale and change the pattern and color of each
element of the graph.

Figure 10-1 shows a typical graph.
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Figure 10-1
A column graph
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The Graph editor produces two-dimensional graphs. The horizontal axis
is referred to as the x-axis and the vertical axis is referred to as the y-axis.
A graph is created by assigning a field to the x-axis and one or more
numeric fields to the y-axis.

The field assigned to the x-axis can be alphanumeric, numeric, date,

or time. 4th DIMENSION automatically groups like x-axis values. For
example, in an Employees database you can assign the Department field
to the x-axis. 4th DIMENSION would automatically sum all values of each
y-axis field for each department. This feature is referred to as “Grouping
on the x-axis” and can be disabled when necessary. When “Grouping on
the x-axis™ is disabled, each record is treated as a separate “group.”

Up to 100 groups can be plotted on the x-axis. There is no limit to the
number of records that can be graphed.

In all graph types, the fields assigned to the y-axis must be numeric.

Up to five fields can be assigned to the y-axis. For example, if you are
graphing data in personnel records, the x-axis field could be Department
and the y-axis fields could be Salary, Expenditures, and so forth.

Data for a graph can be directed from a quick report. When you use this
option, you use the Quick Report editor to do preliminary data processing
prior to graphing data. If you direct a quick report to the Graph editor,

the columns in the quick report are treated as fields in the Graph editor.
For more information on designing a quick report for the Graph editor,
see “Selecting an Output Device” in Chapter 8.

Creating a Graph

The Graph editor graphs the records in the current selection. Before
graphing data, select the records you want to graph. Methods of selecting
records are discussed in Chapter 4.

To create a graph, follow these steps:
Choose Graph from the Report menu.

4th DIMENSION displays the Graph editor, shown in Figure 10-2.
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Figure 10-2
The Graph editor

Select a graph type from the eight templates.

Assign a field to the x-axis by clicking on a field in the Field list. For pie
charts, the x-axis field is used to label slices of the pie.

If you want the graph to display values from low to high (or high to low)
on the x-axis, sort the current selection by the x-axis field before
displaying the Graph editor, or use the proportional x-axis option. For
information on the proportional x-axis option, see the section “Viewing the
Graph™ later in this chapter.

When you assign a field to the x-axis, the non-numeric fields become
dimmed.

Assign one or more numeric fields to the y-axis by clicking on a field or
fields.

4th DIMENSION displays the field names in the y-axis listing. For all graph
types except pie charts, you can assign up to five numeric fields to the
y-axis. Figure 10-3 shows the graph editor after fields have been assigned
to the x- and y-axes.
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Figure 10-3
Graph editor with selected fields

Viewing the Graph

After you have assigned fields to the x-axis and y-axis and selected a
graph type, you can view the graph. When a graph is displayed, you can
also change graph types, assign colors or patterns to elements of the graph,
add pictures, and choose scaling options.

Displaying the Graph

1‘_;_‘ Picture

To display the graph, follow this step:
m  Click Graph to display the graph.
4th DIMENSION displays the graph.

When you display a graph, 4th DIMENSION replaces the current menu bar
with the Graph editor menus, Pictures, Graph Type, and Options. Use
these menus to change pictures in a Picture graph, change the graph type,
or scale the graph.

To change graph types, follow this step:

m  Choose another graph type from the Graph Type menu.

4th DIMENSION redraws the graph in the new format.

If you switched to a pie chart from a type of graph that displayed more
than one y-axis field, 4th DIMENSION graphs only the first field assigned
to the y-axis.



B &verage Salary

USER

Changing the Color or Pattern of an Element

Each element in a graph that is represented in the legend can be assigned a
pattern and color. The color option is available only on monitors that
support gray scale or color. All options are available for column,
proportional column, stacked column, area and pie graphs. The Line graph
and Scatterplots use foreground color only.

To change the color or pattern of an element in the graph, follow these
steps:

Click on the square in the graph legend that corresponds to the element to
be assigned a pattern or color.

The dialog box shown in Figure 10-4 is displayed.

i

[ cancel | || select ||

Figure 10-4

Foreground and background dialog box

Select a pattern from the scrollable list of patterns. If you have a color or
gray-scale monitor, you can select foreground and background colors or
gray scales.

Colors and patterns set for one graph type affect all graph types. These
specifications are saved with the database.

0 L . ) e
711 Note: In multi-user mode, you cannot change these specifications.

Changing the Picture in a Picture Graph

If you chose Pictures as a graph type, you can substitute a custom picture
that you have placed on the Clipboard.
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Pictures
Paste to Y1
Paste to ¥2
Paste to Y3

Paste to Y4
Paste to ¥5

To include a custom picture, follow these steps:
With a Picture graph displayed, copy the custom picture to the Clipboard.

Choose the y-axis field from the Pictures menu that you want to represent
with the picture on the Clipboard.

4th DIMENSION redraws the graph, substituting a proportionally-scaled
picture for each x-axis value in the graph. The same picture is used for

all values of the x-axis field. The height of the picture represents the value
of the y-axis field, not the area of the picture.

Figure 10-5 shows an example picture graph.
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Figure 10-5
A Picture graph

Changing the Scaling of a Graph

To specify scaling, follow these steps:
Choose Scale from the Options menu.

4th DIMENSION displays the Graph Options dialog box shown in
Figure 10-6.
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Figure 10-6
Graph Options dialog box

Click

m  Group on x-axis to request that records with the same value on the
x-axis field be grouped together to form one category. If “Group on
x-axis” is not used, records with the same value on the x-axis will be
treated as separate categories in the graph.

m  Proportional x-axis to draw the x-axis in proportion to the values of
the field assigned to the x-axis. This option is available only when the
field assigned to the x-axis is numeric, date, or time and the type of
graph is either scatter or line.

= Automatic x-scale to turn off the automatic scaling of the x-axis, then
enter the minimum and maximum values you want to use in the graph.
This option is available only when “Proportional x-axis” is checked.

®  Automatic y-scale to turn off the automatic scaling of the y-axis, then
enter the minimum and maximum values you want to use in the graph.
This option is always available.

m  Grid on x-axis to add vertical lines to the graph. The x-axis gridlines
appear only when “Proportional x-axis” is checked.

m  Grid on y-axis to add horizontal lines to the graph. This option is
always available.

Click OK to apply the scaling options to the graph.

Unavailable options are disabled in the Graph Options dialog box.
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Page Setup...

Printing a Graph

After you are satisfied with your graph design, you can print it. The
procedure for printing a graph is the same as the procedure for printing
quick reports or labels.

To print a graph, follow these steps:

While the graph is displayed, choose Print from the File menu. The
standard Print Quality dialog box for your selected printer is displayed.

Click “Preview on screen” if you want to preview the graph before
printing. :

Choose any desired options and click OK.

If you clicked “Preview on screen,” you can print the report when you

preview it by clicking the Print button.

Copying a Graph

You can copy a graph to the Clipboard and paste it into a Picture field in
4th DIMENSION or into another application.

To copy a graph, follow this step:
®  When the graph is displayed, choose Copy from the Edit menu.
4th DIMENSION places the graph on the Clipboard.
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EXECUTING PROCEDURES

The Execute Procedure menu item in the Special menu is used to execute
a global procedure from the User environment. If you are in the process of
writing global procedures, you can test your procedures by switching to
the User environment and using the Execute Procedure menu item.

A global procedure can also be executed from the User environment by
assigning it to an item on a layout menu bar. When you choose an item on
a layout menu bar, the associated procedure is automatically executed.
For more information on layout menu bars, see Chapter 4 of the

4th DIMENSION Design Reference.

Executing Global Procedures

Use the Execute Procedure menu item to select and execute any global
procedure created with 4th DIMENSION’s language. The menu item is
available only if at least one global procedure has been written.

For more information on writing global procedures, see Chapter 6 of
the 4th Dimension Design Reference and Part I of the 4th DIMENSION
Language Reference.
To execute a global procedure, follow these steps:

Special

Edit Output ASCII Map...
Edit Input ASCII Map...

Execute Procedure... %E

1. Choose Execute Procedure from the Special menu.

4th DIMENSION displays the “Execute procedure” dialog box, shown
in Figure 11-1.

Execute procedure...

Disable All

Enable ATl
ExportEmplinfo
MergeDriver

Merge'write (" Cancel
MarStart l tansel
ModDept

ModDeptFrormList Execute |

ModeEmpl

Figure 11-1
The “Execute procedure” dialog box

2.  Select the name of a global procedure in the scrollable list.

3. Click Execute.

i Note: Double-clicking a procedure name is a shortcut for clicking a procedure
name and clicking Execute.
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4th DIMENSION executes the procedure. What happens next depends on
what the global procedure does. A global procedure can perform
calculations, change the current selection, print reports, and even quit the
application and return to the Finder.
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IMPORTING AND EXPORTING DATA

4th DIMENSION’s data importing and exporting facilities provide a fast
and reliable way to transfer information to and from your database. If you
are upgrading to 4th DIMENSION from another database or a spreadsheet,
you can avoid the work of reentering the data from the keyboard by
importing your data. You can import data from Macintosh data
management applications or any non-Macintosh application whose data
has been transferred to the Macintosh.

You can also export data from 4th DIMENSION so that it can be used in
other types of programs that process information. For example, you can
export data to a specialized graphics or statistics program. You can also
transfer the exported data to another type of computer or to a bulletin
board system using a telecommunications program.

You can use an ASCII map when importing or exporting data. An ASCII
map is a translation table used to interpret characters as they are
transferred. An ASCII map is sometimes needed when transferring data
between different types of computers but is rarely needed when
transferring information from one Macintosh program to another.

This chapter describes the data importing and exporting facilities built into
the User environment. These facilities can be used to handle a wide range
of standard data importing and exporting tasks. For advanced or unusual
tasks, you can transfer data using 4th DIMENSION’s language. For more
information about commands related to importing and exporting, serial
port communications, and the creation and management of documents, see
the 4th DIMENSION Language Reference.

You can import or export data using the settings in the appropriate dialog
boxes or using a layout. Importing or exporting using the dialog boxes is
faster than using a layout. However, if you use a layout you can use scripts
or the layout procedure to process data. When you import or export using a
layout, the layout procedure and any scripts attached to fields are executed
for every record that is processed.

When importing or exporting data, you specify the file format, the field
and record delimiters, and the fields to be imported or exported.

Note: You can also use the Quick Report editor to export records. See the
print to disk option in the section “Selecting an Output Device” in Chapter 8.
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File Formats

The file format describes the way in which fields and records are arranged.
Some file formats also include formatting information. 4th DIMENSION
supports three standard file transfer formats:

m SYLK. SYmbolic LinK format.
m DIF. Data Interchange Format.

m Text. This format specifies fields within a record separated by the
end-of field delimiter and records separated by the end-of-record
delimiter. The default field and record delimiters are the tab and the
carriage return, respectively.

Field and Record Delimiters

End-of-field delimiters separate fields and end-of-record delimiters

separate records. The end-of-field delimiters are placed between fields
in a record and the end-of-record delimiter is placed after each record.
Field and record delimiters are used only when using the Text format.

By default, 4th DIMENSION uses the Tab character (ASCII code 09) as the
field delimiter and the Carriage Return character (ASCII code 13) as the
record delimiter. Most Macintosh applications also use these characters.
Usually you can use the default delimiters when you import or export data.

ﬁ Note: ASCII codes in 4th DIMENSION are given in decimal (base 10)
numbers. Appendix D of the 4th DIMENSION Language Reference contains
a table of ASCII codes.

When importing data using the Text format, 4th DIMENSION uses the
delimiters embedded in the file to determine where fields and records end.
When exporting data, 4th DIMENSION automatically places these
delimiters in the file for you.

Be certain that fields do not contain embedded characters that are also used
as field or record delimiters. For example, if the Carriage Return is used as
the record delimiter, no field should contain a Carriage Return. When
importing data, 4th DIMENSION will interpret any Carriage Return as a
record delimiter. Thus, a Carriage Return inside a field will be erroneously
interpreted as the end of that record. An improperly placed Carriage
Return will disrupt the importing process.

When you export data that includes a Text field, a Carriage Return might
be embedded within the field. If this is a possibility, choose another record
delimiter or remove the embedded returns prior to exporting the data.
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Using an ASCII Map

An ASCII map is sometimes needed when transferring information to or
from other applications. For further information about creating and using
ASCII maps, see Appendix A.

You can maintain two types of ASCII maps, input ASCII maps and output
ASCII maps. Use an input ASCII map for importing data and an output
ASCII map for exporting data.

To use an ASCII map, follow these steps:

“poedl 1. Choose Edit Input ASCII Map or Edit Output ASCII Map from the
Edit Output ASCII Map...
Edit Input ASCII Map... Special menu.

Execute Procedure... #E

4th DIMENSION displays the Edit an ASCII Map dialog box.

Special

Edit Output ASCII Map...
Cl ap...

E ASCII M

2. Load or create your ASCII map.
3. Click Use Map.

Any subsequent import or export operations will use the ASCII map.

4. Choose Import Data or Export Data from the File menu and follow
the steps in the next sections for importing and exporting data.

An ASCII map can also be used when the language is used to import
or export data or send or receive data using the serial port. For more
information about using ASCII maps in connection with the language,
see the 4th DIMENSION Language Reference.

Importing Data

You can import data from files in SYLK, DIF, or Text formats. If you are
importing data that has been exported from another application, see that
application’s documentation for information on exporting the data in one
of these formats. If the other application uses a different format for
exporting data, you may need to use the language to manage the importing
process or modify the file in advance using a text or word processor.

If you are importing data from another Macintosh application, first export
the data using the other application. Note the order in which the fields
were exported, the format the program uses to save the data, and, if the
Text format was used, the delimiters used by the program. When importing
the data, you must match these settings.

If your database has more than one file, use the “List of files” window or
the Choose File/Layout menu item to select the file into which you want to
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New Database...
Open Database...

Export Data...

Choose File/Layout...

Import Data...

#®F

import the data. If you need to import data into more than one file, repeat
the importing process for each file.

You do not need to build your entire file structure before you import data.
You can, for example, create one file, import the data, return to the Design
environment, create another file, import the data into the second file, and

so forth.

You have the option of selecting the fields to be imported in the Import
dialog box or specifying an input layout that contains the fields to be
imported.

To import data, follow these steps:
Choose Import Data from the File menu.

The Import Data dialog box shown in Figure 12-1 is displayed.

=— Doc's Drive

tiect ) Open ]

Import data...
[£ Tutorial Databases-old | (

Pﬂrge Setup... N
| ( 0rve ) (conce )
" ) S Persannel10f @Temt OOIF OSYIK
{1 Personnel4f End of field: IZ]
S gs::gg:::z; End of record:
[ Personnel? f [Juse input layout
Field fist aet ot fast N -~
State Zip
Import list ]

Figure 12-1
Import Data dialog box

Select a file format for the data to be imported (Text, DIF, or SYLK).

If necessary, enter new ASCII codes for the end-of-field and end-of-record
delimiters. ASCII codes are listed in Appendix D of the 4th DIMENSION
Language Reference.

Select the fields in the order in which they appear in the file to be
imported. Select the field names displayed in the Field list on the left side
of the dialog box and click Append or Insert to add the field to the Import
list. Clicking Append places the field after the last field in the list. Clicking
Insert places the field before the selected field in the import list. To remove
a field from the import list, select the field and click Remove.
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ﬁ Note: Double-clicking a field is a shortcut for selecting the field and clicking
Append.

Or click the “Use input layout” check box. The fields on the current input
layout will be used in the entry order used in that layout.

If you use the input layout, the Import list does not control the fields that
will be imported. It can be left blank.

The order of the field names in the import list must match the order of the
fields in the file to be imported. You can modify the order of the field
names by removing a field or by inserting a field before a selected field.

ﬁ Note: When importing using a layout, use a layout that only contains the fields
and enterable objects you want to import into.

Select the name of the file to import.
Click Open to begin importing the disk file.

4th DIMENSION displays a progress indicator as it imports the data into
your database.

Exporting Data

When you export data, you create a text file that can be opened by or
imported into other Macintosh applications. If you are exporting data for
use with another application, see that application’s documentation for
information on importing data. Choose a file format and delimiters
compatible with the other application.

In some cases, you may need to edit the exported text file prior to
importing it into the other application. For example, some programs accept
the text file format but require that the first record consist of the names of
the fields. You can add this record using a text processor.

4th DIMENSION exports the records in the current selection and in the
current sort order. For example, if your current selection contains only the
records of sales representatives in Arizona, 4th DIMENSION will export
only this set of records.

You have the option of selecting the fields to be exported in the Export
dialog box or specifying the output layout. If you use the output layout, the
fields on the output layout will be exported.
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To export data, follow these steps:
Set the current selection to include the set of records to export.
Choose Export Data from the File menu.

The Export Data dialog box shown in Figure 12-2 is displayed.

Export data... (2 Untitled
([ Eject ] ([ save ]
el areens - (_ brive ] ( cancel ]
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5] Endof field: [9 |
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Field list

[J Use output layout

Export list

Append >>> irs 1
A

Insert >>> City
State
Zip

Figure 12-2
Export Data dialog box

Enter a name for the file in the “Save as” area.
Select a file format for the data to be exported (Text, DIF, or SYLK).

If necessary, enter new ASCII codes for the end-of-field and end-of-record
delimiters.

Click field names displayed in the Field list on the left side of the dialog
box and click Append or Insert to add the field to the Export list. The fields
will be exported in the order that they appear in the export list. If you plan
to import this file to another Macintosh application, you must specify the
same order when you import the data. To remove a field from the Export
list, click the field and click Remove.

Or Click the “Use output layout” check box. The fields on the layout will
be used in the order specified by the entry order for the current output
layout.

If you use this option, the Export list does not control the fields that will be
exported. It can be left blank.
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ASCII MAPS

An ASCII map acts as a translation table for interpreting character codes
when data is transferred to or from 4th DIMENSION. The transfer can be
a file import or export or a transfer through the Macintosh’s serial port.

An ASCII map can be useful when communicating with non-Macintosh
systems. The upper 128 characters in Macintosh ASCII are unique to the
Macintosh. They represent the symbols seen in the Key Caps desk
accessory when you press the Option and Shift-Option keys. You can use
an ASCII map to translate some or all of these characters. You can also use
an ASCII map to translate some of the control characters (ASCII 00 to
ASCII 31) so that they conform to the requirements of the non-Macintosh
system.

If you use an ASCII map, the map applies to

m importing and exporting data

m serial port communications

m print-to-disk options in the Quick Report and Label editors
m serial printing using Quick Report and Labels editors

Ordinarily, you do not need to create and use an ASCII map. The ability to
edit ASCII maps is a specialized feature that is rarely needed when
transferring information between Macintosh applications.

Unless you use an ASCII map, 4th DIMENSION uses standard Macintosh
ASCII code when information is transferred between it and another
application. A custom map can be used in place of the standard Macintosh
ASCII code to handle special or unusual cases that may come up when
transferring information to or from 4th DIMENSION.

The Macintosh ASCII codes are listed in Appendix D of the
4th DIMENSION Language Reference.

Creating an ASCII Map

An ASCII map is a tool that 4th DIMENSION uses to interpret characters
as they are transferred from another program or source. The map is used
only during the transfer process. The transfer can be done in the User
environment using the Import or Export menu items in the File menu or
done using the procedural language.

A map can be thought of as a translation table. During the information
transfer, the map is placed between 4th DIMENSION and the source or
destination file. The translation table is consulted for each character
that is processed.
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Edit Output ASCII Map...

Edit Input ASCII Map...

Execute Procedure... 3

For each character that is passed to the ASCII map, the map specifies the
character to be returned. 4th DIMENSION receives a character, looks the
character up in the ASCII map, and returns the ASCII character specified by
the map.

Normally, no ASCII map needs to be used because no translation needs to
be done. That is, each character is interpreted as standard Macintosh
ASCIL. If you need only to transfer information to or from other Macintosh
applications, it is unlikely that you will need to create an ASCII map.

When you create an ASCII map, 4th DIMENSION first displays a default
ASCII map. A default ASCII map always returns the same ASCII character
it is passed. You can modify the map by changing the characters the map
will return. You can change as few or as many entries in the map as you
like.

Use the Edit ASCII Map command to create, edit, load, or save ASCII
maps. You can create as many ASCII maps as you like.

ﬁ Note: If you create an ASCII map, you should also create a default ASCII map
and save it as a disk file. Load the default ASCIl map whenever you need to
return to standard Macintosh ASCII. The language can also be used to return
to the standard ASCII map.

To create an ASCII map, follow these steps:

Choose Edit Output ASCII Map or Edit Input ASCIT Map from the Special
menu.

Use Edit Output ASCII Map for exporting data and Edit Input ASCII Map
for importing data.

4th DIMENSION displays the either the “Edit an ASCII map for importing”
or “Edit an ASCIT map for exporting “dialog box.

These dialog boxes are shown in Figures A-1 and A-2, respectively.
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“Edit an ASCII map for exporting” dialog box
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Figure A-2

“Edit an ASCII map for importing” dialog box

A scrollable area displays two sets of ASCII codes and characters. In
Figure A-1, the column labelled “Mac” represents the characters sent from
4th DIMENSION during an export. The column labeled “ASCII” represents
the characters received by the other application. Notice that there is a one-
to-one correspondence between these columns.

In Figure A-2, the column labeled “ASCII” represents the characters
received from the file being imported. The column labeled “Mac”
represents the characters being stored in the 4th DIMENSION database.

Click the ASCII code in the column on the left that you want to map.

If you are using the “Edit an ASCII map for exporting” dialog box, this
column is labelled Mac; otherwise it is labelled ASCII.

4th DIMENSION displays the ASCII code that the map returns in the ASCII
Code area.
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Special
Edit Output ASCII Map...
Edit Input ASCII Map...

Execute Procedure... #E

Special

Edit Output ASCII Map...

Edit Input ASC1I Map...

Execute Procedure... #E

Enter an ASCII code for the character in the ASCII Code area.

The ASCII code you entered appears in the ASCII column in the scrollable
area.

During an information transfer, when 4th DIMENSION encounters the
ASCII code that you mapped, it will substitute the ASCII code that you
entered in the ASCII code area.

For example, if you mapped ASCII code 97 (lowercase A) to ASCII code
65 (uppercase A), the ASCII map will return an ASCII 65 every time it is
sent an ASCII 97. The transferred file will contain a lowercase “a” for
every uppercase “A” in the file that was transferred.

Modify as many additional codes as yoﬁ require.

Click Save to save the ASCII map to a disk file that can be loaded later
for use or editing.

Click Use Map to apply the map you have edited or loaded.

When you transfer information after clicking Use Map, the ASCII map
will be used. ASCII maps are used by the procedural language when
importing, exporting, and performing serial port communications.

To load and use an ASCII map for exporting or importing data, follow
these steps:

Choose Edit Output ASCII Map or Edit Input ASCII Map from the
Special menu.

Use Edit Output ASCII Map for exporting data and Edit Input ASCII Map
for importing data.

4th DIMENSION displays the either the “Edit an ASCII map for importing”
or “Edit an ASCII map for exporting “dialog box.

Press the Load button. A standard open-file dialog box is displayed.
Select the ASCII map from the scrollable list of files.

The map specified by the file will be represented in the scrollable area.
If needed, modify any entries in the map.

Click Use Map to apply the map.

ﬁ Note: The same map loaded for both input and output carries out the
translation in reverse. That is, if a map translates “A” to “a” during an import,
it will translate “a” to “A” during an export.
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Cast of characters

@ (at symbol), as wildcard
character 51-52, 59

$ (dollar sign), in numeric data
format 109-110

> (greater than) 58

>= (greater than or equal to) 58

< (less than) 58

<= (less than or equal to) 58

# (number sign)
in Break row labels 106—107
as comparison operator 58
#D (date of printing) 113
#H (time of printing) 113
in numeric data format
109-110
#P (sequential page number)
113
| (vertical bar), for numeric
style 109

A

Accept button 27, 29, 61

“Access denied” alert box 13-14

access privilege, Design command
and 5

ACCUMULATE command, for
break processing 88

Add Formula button, in Sort editor
79, 80

adding records 57-69

adding text, in Quick Report
layout 99

Add to Line button, in Label
layout 122

<<Add Sort>> marker 96, 103

alert box
“Access denied” 13-14
for excluded value 42
Mandatory field 37-38
Unique field 38
Validation range 38-39

Alpha field 32
entering data into 32
search conditions in 56
alphanumeric fields, in graphs
130
And (conjunction operator) 52,53
Append button, in data import
148
Apple ImageWriter
for labels 124
for quick reports 114
applications, transferring data to
and from 145-150
Apply Formula command 6
for global updates 72
Apply Formula editor, 63
area graphs 129
ascending vs. descending sort
order 78, 80
ASCII codes, for delimiters 146
ASCII driver
for labels 124, 125
for quick reports 114
ASCII map 7, 145, 151
creating 151-3
default 152 saving 152
using 147
ASCII Map dialog box 147
ASCII printer, printing to 116
at symbol (@), as wildcard
character 51-52, 59
Auto column width 96-97,
102-103
automatic break processing 88
automatic column sizing 102
automatic relations
current selection and 48
searching and 50
automatic updating 70-72
Average (summary calculation)
107, 108

B

background display 36, 37
backing up, before sorting 81

USER -

bit-mapped graphics, entering into
Picture field 35-37

Boolean expressions, in Search by
Formula 62

Boolean field
choosing search condition
from 57
in data entry order 28
entering data into 34-35

Break area 105

Break field, sorting on 87

Break field value, inserting in
Break row 99

' BREAK LEVEL command 88

break levels
in quick reports 87-89, 103,
105
role of 87
setting 105-106
break processing 88
Break rows 105
Graph editor and 114
hiding 110
inserting 105-186
inserting text in 99
labels for 106—107
in Quick Report editor 97
summary calculations in 107,
108, 109
breaks, reports with 85
buttons, on layout template 27, 28
Buttons area, in Formula editor
71

C

calculation icons 108-109
calculations
adding to quick reports
107-109
in Break area 105
in Quick Report editor 96, 97
searching and 62-63
in standard reports 87-89
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Cancel button 27, 30
to cancel search 60, 61, 63
for ending data entry 68
in Formula editor 72
in Sort editor 79

carriage return, as record delimiter
146

case-sensitivity, in password
system 13

cells, in Quick Report editor 97,
98

character translation, ASCII map
for 151-3

check boxes, in data entry order
28

Choice List
data entry with 39-42
Excluded 42
modifiable 4142
role of 40
search conditions on 57

Choice List window 40

“Choice of mode” palette 37

Choose File/Layout command
4-5,17,18

Choose File/Layout dialog box 18

“Choose print layout” dialog box
86, 89

Chooser, printer selected in 87,
89, 125

Clear command, for removing
search condition 57

Clear Last button, in Label layout
123

color monitor, graph patterns on
133

columnar format reports. See
quick reports

column graphs 129

column header, in Quick Report
editor 97

column indicators, in Quick
Report editor 96

columns, Quick Report 98
adding 100
assigning formulas to 102

deleting 101

inserting 101

relabeling 102

replacing 101

setting numeric formats for
109-110

sizing 102-103

sorting on 103

width of 96-97

column width cursor 103
Command key, for highlighting

records 25

Command-period

to cancel data entry 30
to cancel search 60
to end data entry 68

commands

ACCUMULATE 88
Apply Formula 6, 72
BREAK LEVEL 88
Choose File/Layout 4-5
Clear 57

Copy 31

Cut 31,57

Delete Column 101
Delete Last Sort 105
Design (Use menu) 5
Edit a Formula 101, 102

Edit Input ASCII Map 7, 147,

152

Edit Output ASCII Map 7,
147, 152

Enter in List 6, 26, 6970

Execute Procedure 7, 141-142

Export Data 4, 147, 149
Graph 7, 130

Hide Line 110

Import Data 4, 147, 148
Insert Break 105-106
Insert Column 101
Labels 7,119

Modify Record 6

New Database 4

New Record 6, 26, 67-68
Open 95

Open Database 4

Page Setup 5
Paste 31, 35-37
Print 5, 86, 89, 116
Printto 113
Quick 7
Quick Report 94
Quit 5
Runtime (Use menu) 5
Save 95
Scale 134
Search Editor 6, 53, 55
Search by Formula 6, 53,
62-63
Search by Layout 6, 53,
58-60
Search and Modify 6, 53,
60-61
Select All 25,73
Show All 6, 25, 48,73
Show Subset 6, 49
Sort File 6, 81
Sort Selection 6, 80-81
Undo 31
User (Use menu) 5
Command-Space bar, for hiding
“List of files” window 20
communications, ASCII map for
151-3
comparison operators 51-52
in search condition 50
in Search by Layout 58-59
symbols used for 58
compound searches 52
creating search condition 57
by layout 58, 59-60
for modifying records 60-61
Conjunction area, in Search editor
55,57
conjunction operators 52
in Search by Layout 59
in Search and Modify 60, 61
control panel
current selection on 48
on layout template 27, 28
Search 59
Copy command 31

Cb mw‘uu( - TlJ) 43



copy operations, entry filter and
39
Count, as summary calculation
107
create-file dialog box
for label design 121
Quick Report designs in 95
for saving formulas 102
for saving search condition 57
Criteria area
in Search editor 55, 56
in Sort editor 79, 80
current selection 47-48
See also Select menu
data export and 149
printing records in 85-87
quick reports from 93-116
search conditions for 50
sorting records in 78, 80-81
updating records in 70-72
custom menus 7-8
custom picture, for picture graph
133-134
Cut command 31
for removing search condition
57
cut operations, entry filter and 39

D

databases
adding records to 29
backing up before sorting 81
data file 10
elements of 10
opening 10
password-protected 12-13
periodic updates of 29
permanent sorting of 81
searching 47, 49-63
structure file 10

data entry 2644
Accept button 29
adding records 57-69
Cancel button 30
with Choice lists 3942
Delete button 31

editing during 31
enterable areas 28-29
with entry filter 39
with Excluded list 42
in fields with attributes 37-38
field types and 32-38
with included layout 42-44
input layout elements 26-27
interrupting 31
layout templates 27-28
modifying records 57, 69-70
navigation buttons 30
in output layout 25-26
page navigation buttons 30
updating records 57, 70-72
with validation range 38-39
data entry order 28-29
data file 10
name of 10
periodic updates of 29
remote 1011
data import and export 145-150
ASCII map for 1514
Data Interchange Format (DIF)
files 146
data management operations 3—4
data type, data entry and 32-37
data validation
entry filter 39
validation range 38-39
date, adding to quick report 113
Date fields
entering data into 33
in graphs 130
default ASCII map 152
default delimiters 146
default layouts 17, 18
Delete button 27, 31, 73
in Sort editor 79
Delete Column command 101
Delete key 31
Delete Last Sort command 105
deleting a sort field 105
delimiters, end-of-record/end-of-
field 146
Design command (Use menu) 5

Design environment
access to 13
Alpha field length set in 32
for creating labels 119
for custom menus 7-8
included layouts specified in
43
for saving layout changes 17
specifying update interval in
29

Detail cell, numeric format for
109-110

Detail row 97

formula results for 102
hiding 110

dials, entering data with 29

DIF files 146

Direct ASCII driver 114
for labels 124, 125
printing to 116

disk file
printing to 94, 114, 116
saving search condition as 57

display formats, for Picture field
35-36

dollar sign ($), in numeric data
format 109-110

double-clickable included layouts
43

double-clicking, in output layout
25

E

“Edit an ASCII map for
importing/exporting” dialog
boxes 1524

Edit Formula button, in Sort editor
79

Edit a Formula command 101,
102

editing 31
See also modifying records
in Quick Report layout 99
in Text field 33
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Editing area, in Formula editor
71,72

Edit Input ASCII Map command
7,147,152

Edit menu 5
Clear command 57
Copy command 31
Cut command 31, 57
Delete Column command 101
Hide Line command 110
Insert Break command
105-106
Insert Column command 101
Paste command 31, 35-37
Select All 73
Select All command 25
Undo command 31

Edit Output ASCII Map command
7,147,152

end-of-field/end of record
delimiters 146

enterable areas 27, 28-29
entry filters in 39

enterable layout 42

Enter button
for accepting modified record
69
for accepting new record, 68

entering data. See data entry

Enter key
for adding or saving record
26, 29, 68
to begin search 60

Enter in List command 6, 26,
69-70

Enter in List mode 23, 24, 25-26
for modifying records 69-70

Enter menu 6
Apply Formula command 6,
72
Enter in List command 6, 26,
69-70
Modify Record command 6
New Record command 6, 26,
67-68

Enter Password dialog box 12-13
entry filter 32
Alpha field and 32
data entry with 39
defined 39
environments, switching between
5
EPSF graphics 35

File buttons, in Label editor 120
file formats 146
File menu 4-5
Choose File/Layout command
4-5,17,18
Export Data command 4, 147,
149
Import Data command 4, 147,

error correction, in data entry 31 LH 148

EtherNet 8

Except (conjunction operator) 52,
57

Excluded list, data entry with 42

Execute Procedure command 7,
141-142

Execute Procedure dialog box
141

Export Data command 4, 147,
149

Export Data dialog box 149-150

exporting data 145-147, 149-150
ASCII map for 151-3

Export list 150

external procedures, in Formula
editor 71

F

Field area
in Formula editor 71
in Search editor 55
in Sort editor 79
field attributes, data entry and
37-38
field names
in quick reports 100
in search condition 50
fields 17
adding to labels 121-122
end-of-field delimiters 146
moving between 26
Fields box, in Label editor 120
Field Selection box, in Quick
Report editor 96, 100, 101
field type, data entry and 32-38

New Database command 4
Open command 12, 95

Open Database command 4
Page Setup command 5

Print command 5, 86, 89, 116
Print to command 113

Quit command 5

Save command 95

filenames
data files 10
structure files 10
files

choosing 17-20
importing data to 147-149
number of layouts for 17
permanent sorting of 78, 81
Quick Report design 95
role of 17
saving formulas as 102

file server, in multi-user mode 8,
9

First Page button 30

First Record button 30

folders 10

fonts, for quick reports 99-100,
112-113

font sizes, for quick reports 100,
112-113

footers, for quick reports 111-113

Foreground and Background
dialog box 133

Formula editor 63, 71-72
for global updates 70-72
for quick reports 102
in sorting 80



formulas
adding to quick report 102
for global updates 70, 72
saving as files 102
searching by 53, 62-63
sorting on 80, 103

4th DIMENSION
multi-user requirements 8-9
transferring data to and from
145-150

4th DIMENSION runtime, in
multi-user mode 8-9

frame, for quick report 96

full-page data entry, with included
layout 43, 44

G
global procedures
for break processing 88
executing 141-142
in Formula editor 71
global updates 57, 70-72
Graph button 132
Graph command 7, 130
Graph editor 129-135
menus 132
printing quick reports to
114-115
role of 4
graphics
See also Graph editor; graphs
entering into Picture field
35-37
in reports 85
Graph Options dialog box
134-135
graphs 129-135
See also Graph editor;
graphics
changing elements in 133

changing picture in 133-134
changing scaling in 134-135
color and pattern in 133

creating 130-135
printing to 94, 116
viewing 132

Graph Type menu 132

greater than (>) 58

greater than or equal to (>=) 58
grouping on the X-axis 130
guests 13

H

hard disk, periodic updates on 29

Header row, in Quick Report
editor 97
editing text in 99

headers, for quick reports
111-113

Hide Line command 110

hiding Quick Report rows 110

highlighting, in output layout
24-25

|
icons
for layouts 18, 19
summary calculation 108-109
for typed passwords 13
ImageWriter Serial Driver dialog
box 114
Import Data command 4, 147,
148
Import Data dialog box 148
importing data 145-149
ASCII map for 1514
Import list 148
included layouts 42
in data entry order 28
data entry with 42-44
double-clickable 43
in reports 85
indexed fields, searching and
modifying 60-61
indexed records, sorting on 77
indexed search 50-51
indexes 10, 51
input ASCII maps 147
input layouts
See also layouts
adding records in 67-68
deleting records from 72-73

U]

elements of 26-27

icons for 18, 19

importing data to 148-149
included 42-44
modifying records in 69
role of 3,23

searching in 50, 58-60
sorting in 77

templates for 27-28

using 2644

viewing from output layouts
25

~ Insert Break command 105-106

Insert button, in data import 148
Insert Column command 101
Integer field, entering data into 32

J,K

justification, in quick reports 100,
112-113

keyboard equivalents, for radio
buttons 35

Keyword area, in Formula editor
71

L
label designs, saving and loading
121
Label editor 4, 119-121
getting to 119
print options in 125
Label layout 120, 121-122
Label page preview 120
labels 119-125
for Break rows 106
creating designs for 121-124
output devices for 124-125
previewing 123
printing 125
in Quick Report layout 99
“Labels across”/“Labels down”
boxes, in Label editor 120
Labels command 7, 119
Last Page button 30
Last Record button 30
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Layout editor
for creating labels 119
for custom menus 7-8
included layouts specified in
43
templates in 27-28
layout icons 18, 19
layout menu bars, for executing
procedures 141
layout procedures, in data entry
32
layouts 3
See also input layouts; output
layouts
choosing 17-20
for data import or export 145
default 17
files and 17
included 4244
maximum number per file 17
parent 42
for quick report 96
reporting using 85-89
role of 17,23
saving changes to 17
searching in 58-60
layout templates 27-28
less than (<) 58
less than or equal to (<=) 58
Line buttons, in Label editor 120
line graphs 129
“List of files” window 17, 19-20
hiding 20
Load button, in Formula editor 72
loading a formula 63, 72
loading label designs 121
loading a Quick Report design 95
Long integer field, entering data
into 32

M

Macintosh applications,
transferring data to and from
145-150

Macintosh user guide, editing
operations in 5

mailing labels. See labels
Mandatory field, entering data into
37-38
Mandatory attributes alert box 38
Mandatory attribute 37
margins, for labels 120, 123. See
also right margin marker
Maximum (summary calculation)
107, 108
menu items, selecting in data entry
31
menus
See also specific menus
custom 7-8
in User environment 4—7
Minimum (summary calculation)
107, 108
modifying records 6, 57, 69-70
in output layout 25-26
searching and 53, 60-61
modifying text, in Quick Report
layout 99
Modify Lists dialog box 41
Modify Record command 6
multi-line data entry, into included
layout 42
multi-page layouts, saving records
in 29
multiple-file databases
current selections in 48
searching in 50
multiple sort levels, on Quick
Report layout 104
multi-user mode 8-9
entering a password-protected
database 11-12
graph color or pattern in 133
guest access in 13
lists and 41
opening remote data files
10-11
output layout title bar 47
selecting 9
temporary files in 9-10
multi-user radio button 9

N
navigation buttons 27, 30
in modifying records 69
in searching 50
network, for multi-user mode &
New Database command 4
New Line button, in Label layout
121, 122
New Record command 6, 26,
67-68
Next Page button 30
Next Record button 30
number sign (#)
in Break row labels 106—107
as comparison operator 58
#D (date of printing) 113
#H (time of printing) 113
in numeric data format
109-110
#P (sequential page number)
113
numeric data, Quick Report
formats for 109-110
numeric fields
entering data into 32
in graphs 114, 130

0
object-oriented graphics, for
Picture field 35-37
On Background display format 36
Open command, for a Quick
Report design 95
Open Database command 4
“Open data file” dialog box, 10-11
open-file dialog box
for label designs 121
for Quick Report designs 95
opening a database 4, 10
Operator area, in Search editor
55,56
Options menu, Scale command
134
Or (conjunction operator) 52



Other menu
Delete Last Sort command
105
Edit a Formula command 101,
102

output ASCII maps 147

output devices, for quick reports
113-115

output layouts
See also layouts
adding records in 67, 68—69
for creating labels 120
current selection on 48
deleting records from 72-73
Enter in List mode 23, 24,
25-26
icons for 18, 19
modifying records in 69-70
moving between fields in 26
normal mode 24
role of 3,23
searching in 50
selecting all records in 48
selecting record subset in 49
sorting on 77
standard reports with 85-87
title bar 4748
using 23-26

P
page headers, for quick reports
111-113
Page navigation buttons 30
page numbers, adding to quick
report 113
Page Setup command 5
Page Setup dialog box 86, 89, 119
parent layout 42
password-protected database
entering 11-12
using 12-13
Paste command 31, 35-37
paste operations
entry filter and 39
with graphics 35-37
in Text field 33

PICT2 format 35-37

PICT format 35-37

picture areas
in data entry order 28
in reports 85

Picture fields
display formats for 35-36
entering data into 35-37
in reports 85

Pictures graph type 129
changing picture in 133-134
changing scaling of 134-135

custom picture for 134
pie charts 129
pop-up menus, entering data with
29
PostScript graphics 35
PostScript printer 94
Preferences dialog box, for update
interval 29
previewing labels 120, 123
“Preview on screen’ check box
for quick report 116
for standard report 86, 89
Previous Page button 30
Previous Record button 30
Print command 5, 86, 89, 116
“Print to” command 113
printers
for labels 119
for quick reports 94
Printer setup dialog box, for labels
125
printing, canceling 116
printing to disk, ASCII map for
1514
printing labels 125
output device options
124-125
test printing 124
printing quick reports 116
hiding rows from 110
output device options 94,
113115

R

page headers and footers for
111-113
printing standard reports 85-87
with break levels 87-89
Print Quality dialog box 86, 89
“Print to” button, for labels 124
“Print to” dialog box 113
for labels 124-125
procedural language, data transfer
with A3
procedural processing, in reports
85

_ procedures, executing 141-142

proportional column graphs 129

Q

Quick command 7, 94

Quick Report design, loading and
saving 95

Quick Report editor 93-116,
96-97
column sizing in 102
for exporting data 145
getting to 94
role of 4
sorting records in 103-105
summary calculation options
in 107

Quick Report Format dialog box
111-113

Quick Report layout 96
adding columns to 100
adding or modifying text in 99
adding summary calculations
to 107-109
Break row labels in 106-107
deleting columns from 101
inserting columns in 101
numeric formats in 109-110
replacing columns in 101
selecting rows, columns, and
cellsin 98
sort order in 103-105
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quick reports
See also Quick Report editor;
Quick Report layout
accepting page setup for 113
adding columns to 100
adding formulas to 102
adding page numbers to 113
adding time and date to 113
deleting columns from 101
elements of 94
example 93
font, font size, style, or
justification for 100
graphs from 114-115, 130
hiding rows in 110
inserting columns in 101
output devices for 94,
113-115
page headers and footers for
111-113
printing 116
replacing columns in 101
sizing columns for 102-103

Quit command 5

R

radio buttons
Boolean field 34, 35
in data entry order 28

Real field, entering data into 32

records 17
adding, 29, 57-69. See also
data entry
adding in output layout 26
canceling 30
deleting 31,73
end-of-record delimiters 146
global updating of 57, 70-72
grouping for graphs 130
highlighting in output layout
24-25
modifying 57, 69-70
modifying in included layout
43, 44

moving among 30
saving 29
searching through. See
searching
selecting, 47-63. See also
Select menu
selecting all 25, 48
selecting a subset of 49
sorting 77-81
sorting for quick reports
103-105
related files
current selection in 48
searching in 50
remote data file, opening 1011
Report with Frame check box 96
Report menu 7
Graph command 7, 130
Labels command 7, 119
Quick command 7, 94
reports, standard 85-87
See also quick reports
with breaks 85, 87-89
output layouts for 85-89
previewing on screen 86-87,
89
Return key
for data entry 29
in Text field data entry 29, 33
right margin marker, in Quick
Report editor 97
Routines area, in Formula editor
71
row label bar
break level labels in 106
in Quick Report editor 97
rows, Quick Report 98
hiding 110
rulers, entering data with 29
Runtime command (Use menu) 5
Runtime environment
network users and 8
password access system for 12

S
Save button, in Formula editor 72
Save command, for a Quick
Report design 95
saving a formula 62, 63,72
saving label designs 121
saving records 29
Scale command 134
Scaled to Fit format 36
scatter graphs 129
screen display
previewing quick reports on
116
previewing standard reports on
86-87, 89
scripts, in data entry 32
scrollable areas, entering data with
29
scroll bars, in Quick Report editor
97
scrolling, in output layout 24
Search button 59, 60
search conditions
comparison operators for
51-52
compound 52, 57
creating 55-57
defined 49
elements of 50
formulas in 62-63
modifying 57
removing 57
saving as disk files 57
Search editor 53-57
creating search conditions in
55-57
Search editor buttons 55
Search Editor command 6, 53, 55
Search by Formula command 6,
53, 62-63
searching 47, 49-63
comparison operators for
51-52
conjunction operators for 52
by formula 62-63
indexed 50-51



by layout 58-60
and modifying 60-61
Search editor for 53-57
Search menu items 53-63
sequential 50-51
simple vs. compound searches
52
Search by Layout command 6,
53, 58-60
Search and Modify command 6,
53, 6061
Search and Modify dialog box
60-61
Search in selection check box 55
Select All command 25
for deleting records 73
selection, current 4748
Select menu 6-7, 53
Search Editor command 6, 53,
55
Search by Formula command
6, 53, 62-63
Search by Layout command 6,
53, 58-60
Search and Modify command
6, 53, 60-61
Show All command 6, 25, 48,
73
Show Subset command 6, 49
Sort File command 6, 81
Sort Selection command 6,
80-81
sequential search 50-51
serial port communications,
ASCII map for 151-3
serial printing
ASCII map for 151-3
labels 124, 125
quick reports 94, 114
Shift key, for highlighting records
25
Shift-Tab, for data entry 29
shortcuts
for appending fields 149, 150
in Formula editor 70, 71, 72

Show All command 6, 25, 48, 73
Show Subset command 6, 49
simple search 52
by layout 58-59
Single- or Multi-user dialog box 9
Sort box, in Quick Report editor
96, 103-105
Sort button, in Sort editor 79
sort conditions, saved 79
Sort editor 79
for permanent sorting 81
sort fields
break levels 105
changing 105
deleting 105
marking 103-104
on Quick Report layout
103-105
Sort File command 6, 78, 79, 81
sorting 77-81
ascending vs. descending order
78, 80
on a formula 77
on indexed records 77
for quick report 96, 103-105
for standard report 87
types of 78-79
sort levels 77-78
break levels and 87, 105
on Quick Report layout 104
sort order
data export and 149
for quick reports 103—-105
Sort Selection command 6, 78
Sort Editor and 79
using 80-81
Special menu 7
Edit Input/Output ASCII Map
command 6,7, 147, 152
Execute Procedure command
7, 141-142
stacked column graphs 129
standard reports 85-87
Stop Printing button 116
structure file 10
in multi-user mode 8§, 9

USER

name of 10
Style menu, for quick reports 100
styles, in quick reports 100
numeric format 109
for page headers and footers
112-113
subfields
in quick reports 100
in search conditions 54
subfiles, searching in 54
subrecords, searching on 54
subset of records
changing 4849
creating 49
Subtotal function, break
processing and 88
summary calculation icon
108-109
summary calculations
adding 107-109
in Break area 105
labeling 99
summary calculations check
boxes, 96
Sum (summary calculation) 107,
108
Symbolic Link format (SYLK)
files 146

T
Tab character, as field delimiter
146
Tab key
for data entry 29
in Enter in List mode 26
Text field and 33
temporary files 9-10
text
in Break row labels 106-107
in Quick Report layout 99
Text fields
entering data into 33
exporting data from 146
Return key in 29
search conditions in 56
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text files 146
exporting data to 149-150

thermometers, entering data with
29

“This record has been modified”
alert box 31

TIFF graphics 35

time, adding to quick report 113

Time fields, entering data into
33-34

time fields, in graphs 130

title bar
current selection on 4748
output layout 4748

Totals row, 97
for Break row 105
hiding 110
inserting text in 99
summary calculations in 107,
108, 109

Truncated display format 35-36

U
Undo command 31
Unique field, entering data into 38
Unique field alert box 38
Unique field attribute 38
update interval 29
updates, global 57, 70-72
“Use input layout™ check box 148
Use layout check box, in Label
editor 120
Use Layout option, in printing
labels 125
Use Map button 147
Use menu 5
Design command 5
Runtime command 5
User command 5
“Use output layout” check box,
for data export 150
User command (Use menu) 5
User environment 3—4
custom menus appended to
7-8
data import and export

facilities 145-150

data transfer in 151

executing global procedures
from 141-142

layouts in 17

menus, 4-7. See also specific
menus

password access system for 12

\'}

validation range, data entry with
38-39

Validation range alert box 38-39.

Value area, in Search editor 55,
56

values
in search condition 50
validation range 38-39

vertical bar (l), for numeric style
109

w

wildcard character (@)
in search condition 51-52
in Search by Layout 59





